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Chapter 1: Potential Hazards and Safety Precautions 
 
The nanoXCT is designed to be safe for the operator as well as maintenance and service 
personnel. However, potential hazards to the operator and the instrument do exist. This 
section describes the potential hazards, their isolation, and control methods. Please read and 
understand this chapter before running or maintaining the instrument. 

1.1 Personnel hazards 

The nanoXCT uses x-rays up to 35-40 keV when imaging. Consequently, a high-voltage power 
supply is required to generate the high-energy radiation, and a shielding enclosure is required 
to contain the radiation. Potential hazards to the operator are described below. 

1.1.1 High voltage 

Severity: Major to hazardous 

Likelihood of occurrence: Extremely remote 

 

The x-ray source requires high voltage of up to 40 kV in normal operation. The high-
voltage power is within the x-ray source in the enclosure. 
Hazards from electrical sources of up to 250 V are also present. Severe or catastrophic 
injuries are unlikely and minor to moderate injuries are rare. The risk from electrical 
systems is low. 

Potential damage 

Severe to catastrophic injuries may result from electrocution by the high 
voltage source. Electric shock from hazardous voltage sources may result in 
minor to moderate injuries. 

  Hazard control 

All high voltage sources are sealed and interlocked. Sources with voltages of 
up to 120 V are contained in locked cabinets and require a key to access. 
Operators and maintenance personnel should follow proper lockout/tagout 
procedures before attempting any service on the nanoXCT. Do not touch 
unknown conductor leads in the system or use conductive fluid near the x-ray 
source or its power supply. The optical table and all components mounted to 
the optical table are earth-grounded. Electrical faults will be shorted to ground. 
Depress the EMO button in an emergency. 

 

1.1.2 Ionizing radiation 

Severity: Major to hazardous 

Likelihood of occurrence: Extremely improbable 

 

The x-ray source generates x-rays up to 35-40 keV, with intense peaks at 5.4 or 8.0 
keV used for imaging. 

Potential damage 

Prolonged exposure to x-ray radiation can cause moderate to severe illness to 
the personnel mostly in the form of soft tissue damage or cancer (in severe 
cases). 

Hazard control 

The radiation is isolated from the user by a protective enclosure with fail-safe 
interlock systems. The radiation level outside the enclosure is not measurable 
above background level during normal operation. Please do not attempt to 
defeat the interlock system. Press the EMO button in an emergency. Xradia 
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personnel will perform a radiation survey during a regularly scheduled service 
every 12 months. The radiation survey should also be performed if any part of 
the enclosure is modified. 

1.1.3 Pinch hazards 

Severity: Minor 

Likelihood of occurrence: Remote 

 

The radiation-shielding enclosure is made of steel plates with considerable weight. 
Placing body parts in their path when it is being closed can cause bodily injury. Minor 
injuries may occur in rare occasions. Serious injuries are extremely unlikely. The risk 
from the pinch hazards is minimal. 

Potential damage 

Physical pain or minor injuries can result from the pinch. 

Hazard control 

Exercise caution when opening or closing the door to the enclosure. If body 
parts are caught in a closing enclosure, simply reverse the motion of the 
enclosure to free them. 

1.1.4 Magnetic field 

Severity: Minor 

Likelihood of occurrence: Extremely remote 

 

The nanoXCT contains a number of motors that generate low levels of magnetic field, 
as well as magnetic latches to seal the enclosure doors. Minor damage to personnel or 
equipment may occur, but this is extremely unlikely. The risk from magnetic fields is 
slight. 

Potential damage 

The magnetic field strength is extremely low. Damage to personnel or 
equipment is extremely unlikely. 

Hazard control 

Be aware of the presence of the magnetic field around the motors and 
enclosure. Persons using a pacemaker or with objects that are sensitive to 
magnetic field should exercise caution. 

1.1.5 Hazardous materials 

Severity: Hazardous 

Likelihood of occurrence: Extremely remote 

 

The nanoXCT contains the following materials that may be hazardous. Please be aware 
of their presence and us caution when working inside of the instrument. 

• Beryllium - Beryllium windows are used on the x-ray source, condenser 
chamber, and flight tube. The total quantity of beryllium is approximately 20 
g. Windows on the condenser chamber and flight tube are exposed, and 
personnel should exercise caution when working around them. 

• Thallium doped Cesium Iodide – Thallium doped Cesium Iodide is 
integrated into the detector system. The quantity is approximately 2.5 mg. 
The Thallium content is approximately 1% by weight. It is not exposed, and 
risk of exposure to the operator or service personnel is very low. Xradia will be 
responsible for disposal when necessary. 
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• Lead – The inside of the x-ray source contains a small lead shutter. These 
parts are not accessible to the operator or personnel performing routine 
maintenance. 

Please refer to the appropriate MSDS for details on each material. 

1.2 Equipment hazards 

1.2.1 Collision of moving parts 

Severity: No safety effect 

Likelihood of occurrence: Remote 

 

Motorized components may collide when they are moved out of their normal operating 
ranges. Collisions are most likely to occur when moving all components during 
homing, or when using the standard clip sample holder and rotating the sample theta 
stage to high angles. Damage will be minor in most cases. Severe damage will be 
rare. The risk from collision is low. 

Potential damage 

Collisions may cause misalignment and, in more severe cases, damage to sub-
components. 

Hazard control 

Use caution when moving motors. Avoid moving a motor to a position outside 
its normal operating range. Make sure that the sample holder is correctly 
placed on the sample stage when loading a sample into the microscope. Watch 
the components during homing. Perform one rotation to the maximum angle 
and watch the motion before beginning tomography. Depress the MOTION 
STOP button in an emergency. 

1.3 Explanation of safety labels 

1.3.1 Safety labels 

 
Symbol Meaning 

 

This location is a ground point. All points 
bearing this indicator make electrical contact 
with each other.  

 

 
 

The equipment behind this indicator may only 
be serviced by qualified personnel. This 
extends to Xradia service personnel and 
others as authorized.  

 

 
 

The equipment produces ionizing radiation 
primarily in the x-ray spectrum. There should 
be no detectable radiation outside of the 
enclosure during normal operation, but 
radiation is present inside the enclosure. 

 This cover is not to be removed except by 
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authorized personnel employing appropriate 
safety precautions.  

Table 1-1: Safety labels located throughout nanoXCT
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Chapter 2: Overview of Components 
 
The Xradia nanoXCT laboratory tool consists of a rotating anode x-ray source, train of x-ray 
optics, and a high-resolution detector. A brief overview of each component is outlined here, 
but a detailed explanation of the physics behind operation is presented elsewhere. 

2.1 Overview of Components and Staging 

 
Fig. 2-1: Overview of the nanoXCT components. 

2.2 X-ray source 

 
Fig. 2-2: Rotating-anode x-ray source. 

 
The nanoXCT laboratory tool uses a rotating anode x-ray source with either copper (8 keV) or 
chromium (5.4 keV) target material. Accelerated electrons from the filament (cathode) collide 
with the anode, temporarily dislodging electrons in a ~70 µm spot (FWHM) on the surface of 
the anode to excited states. When these electrons cascade back to their stable states, 
radiation of characteristic spectra is produced, depending on the target material. If a copper 

X-ray source 

Condenser 

Pinhole 

Sample 

Objective 
zone plate 

Phase ring 

Bertrand lens 

Flight tube 

Detector 
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anode is used, the peak of highest intensity is the Kα line, which corresponds to ~ 8.0 keV; for 
chromium, the most desirable peak is at ~5.4 keV.  
 

2.3 Condenser 

  
Fig. 2-3: Condenser chamber (left) and condenser mounted on ferrule (right). 

 
Photons emerge from the x-ray source in all directions, and thus are subject to a fast decrease 
in projected flux-density as they move downstream. Roughly 150 mm from the source, an 
elliptical capillary lens is positioned to capture and reflect the light. This lens is called a 
condenser, and is designed with a 1:1 magnifying geometry such that the 70 µm spot of the 
x-ray source is “condensed” back to its original size ~300 mm from the source. Similar to a 
visible-light microscope or TEM, the position of focus is the optimal location for the sample. On 
the downstream edge of the lens, a thick Au stop is glued to block the beam from passing 
directly through the center of the tube. 
 

2.4 Pinhole 

 
Fig. 2-4: Pinhole mounted on custom hex wrench. 

 
The reflected light from the condenser is multi-ordered, but nanoXCT relies on a single focal 
spot in order to function with optimal performance. The brightest nonzero reflection is the first 
order, and higher orders are generally too weak for imaging with the table-top source. In 
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order to isolate the first order, a pinhole aperture is inserted ~140 mm  downstream of the 
condenser, just before the sample. A 60 µm pinhole is used for the high-resolution 
configuration, and 150 µm for large field of view. 
 

2.5 Objective Zone plate 

 

 
Fig. 2-5: Zone plate mounted on holder. 

 
After the light passes through its focus (at the sample position), it begins to diverge. At a 
calculated position downstream from this location, another focusing optic is positioned, called 
a Fresnel zone plate. Zone plates are diffractive optics made with circular “zones” of material 
(Au, in this case), where the focal length, depth of focus, and imaging resolution are 
dependent on the size of the smallest outermost zones. The total magnification of the system 
is then dependent on the positions of the detector and sample relative to the objective zone 
plate. 
 

2.6 Phase ring 

 

 
Fig. 2-6: Phase ring holder. 

 
Some of the 1st order light from the condenser is not diffracted by the sample, but is still 
focused by the outer zones of the zone plate, contributing to the background and, thus, 
reducing contrast. To reduce the effective contribution of this illumination, Xradia has 
integrated a Zernike phase contrast mode of operation. In this mode, a metal ring with 
roughly the same numerical aperture as the zone plate, is inserted into the optical train at a 
distance such that it intercepts the focused, undiffracted light in the back focal plane of the 
zone plate. The annular ring, made from Au for the 8 keV system and Ni for 5.4 keV, is 
manufactured with a precise thickness such that it shifts the phase of the illumination by 3π/2 
(±π/8), so that when the undiffracted light recombines with that which was diffracted, the net 
effect is a phase cancellation of the background. This produces negative Zernike phase 
contrast, where features with net positive phase shift appear dark. 
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Fig. 2-7: Ray diagram of nanoXCT optical components. 

2.7 Bertrand lens 

 

 
Fig. 2-8: Bertrand lens holder (boxed). A phase 
ring holder is also pictured (right). 

 
In order to aid alignment of the phase ring, Xradia supplies another zone plate to match, 
which is configured to image the light in the back focal plane of the zone plate. This 
intermediate lens is called a Bertrand lens, and is only used during alignment of the phase 
ring. 
 

2.8 Flight tube 

 

 
Fig. 2-9: Flight tube. 

 
Normal air, consisting primarily of N gas, is significantly absorbent of 8 keV and 5.4 keV 
photons. At 8 keV over the distance between the optics and detector, this can lead to as much 
as a factor of 2 throughput loss, and is much more dramatic at 5.4 keV. To minimize this 
effect, a flight tube is installed to cover the majority of the path length, which is filled with ~ 3 
PSI of He gas. The gas is sealed by a thin Be window at the entrance, which is very fragile and 
should be left alone. The flight tube is equipped with a pair of valves for venting the chamber 
when filling or servicing.   
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2.9 Transmission detector system (TDS) 

 

 
Fig 2-10: nanoXCT detection system. 

 
The final component of the nanoXCT system is the transmission detector system (TDS). This 
detection system consists of two different magnifying, scintillating lenses (2X magnification for 
alignment and 20X for imaging), mounted on a motorized, software-controlled objective 
shifter. These lenses convert the x-ray photons to the visible-light spectrum, and are then 
focused by a non-magnifying tubelens onto the 16-bit, Peltier-cooled CCD detector.  

2.10 Component positions (design) 

 

Component 
Position (mm) 

HRES LFOV 

Source -300 -300 
Condenser Entrance -159 -159 
Condenser Center -150 -150 
Condenser Exit -141 -141 
Sample 0 0 
Objective Zone Plate 18.52 67.61 
Phase Ring 38.76 153.51 
Bertrand Lens 163.85 223.12 
Detector 754.4 754.4 

Table 2-1: Designed positions (relative to the sample) 
for the x-ray optical components of nanoXCT. 
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2.11 Pre-alignment microscope (PAM) 

The nanoXCT system comes with an optical microscope, called the pre-alignment microscope. 
When properly calibrated to the nanoXCT, this device greatly aids in region-of-interest location 
before using the x-ray system. Two objective lenses are available with 10X and 50X 
magnification, as well as transmission and reflection illumination modes. 
 

 
Fig. 2-11: Pre-alignment microscope 
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Chapter 3: System Alignment 
 
In the following procedure, it is assumed that the microscope is completely misaligned. If only 
minor changes are necessary, skip the direct-beam method and proceed to the alignment of 
the x-ray optics. It is recommended to check the alignment of the x-ray optics at least once a 
week, as components may drift during normal operation. 

3.1 Direct-beam method 

The technique outlined in this section begins with aligning the condenser, and then uses the 
circle annotation tool to mark the center of the cone of reflected light. All other components 
are then individually aligned to the center of the circle, thus locating approximate aligned 
positions with respect to the beam). 

a. Locate direct beam 
To begin, move all components out of the way so that the direct beam is visible in the 
2X objective (in the picture here, the direct beam is shown through the aperture of the 
flight tube).  

 
Fig. 3-1: Direct beam image, apertured by 
the flight tube. A small burr in the tube is 
visible on the right side of the image. 

 
b. Condenser 

Using a combination of the condenser x/y and tip/tilt motors, adjust the condenser 
position so that the first-order reflected light evenly surrounds the projection of the 
stop (appearing as the “hole” in the middle of the “doughnut”). Then, using the circle 

annotation tool , draw an outline of the reflected light and save the image. 

 
Fig. 3-2: Image of the aligned condenser. 

 
c. Pinholes 

Move the condenser out of the way so that direct beam is again visible. Open the 

condenser image, and use the pointer tool  from the annotation menu to select the 
circle drawn in the previous step. After selecting the circle with the left mouse button, 
click the right mouse button and select “copy.” Begin a continuous image collection 
using high binning (matched to that used in part a) and short exposure time. On the 
new live image, right click and select “paste.” Finally, use the pinhole x/y motors to 
steer each pinhole to the center of the circle.  
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Fig. 3-3: High-resolution (60 µµµµm, left) and large field-of-

view (150 µµµµm, right) pinhole projections. 

 
Once alignment is complete, save each image with the annotation. 
 
Note: The two different pinholes are located on the same holder, and are separated by 
~ 3 mm vertically with minimal horizontal shift. 
 

d. Zone plates 
As in the previous step, move the pinhole out of the way so that direct beam is again 
visible. Begin another continuous acquisition, as before, and copy and paste the circle 
onto the new window. Use the zone plate x/y motors to position each zone plate to the 
center of the circle, saving each aligned image. 
 

  
Fig. 3-3: High-resolution (ZP35-80-7, left) and large field-
of-view (ZP30-320-4, right) zone plate projection images.  

 
e. Phase rings 

Repeat the same procedure as before to align the phase rings. The PR64 contains four 
phase rings in a 200 µm x 200 µm grid pattern, so it is best practice to align to a point 
near one corner of the membrane. In practice, the phase ring used on the PR64 
membrane is generally in the upper right corner, but aligning to any corner will allow 
navigation to any of the other phase rings. 

  
Fig. 3-4: High-resolution (PR64-4.75-2.7, left) and large field-
of-view (PR215-13-2.7, right) phase ring projection images. 
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f. Bertrand lenses 
Repeat the same procedure as before to align the Bertrand lenses. 
 

  
Fig. 3-5: High-resolution (ZP100-160-16, left) and large 
field-of-view (ZP30-320-4 w/ 300 µµµµm OSA) Bertrand 

lens projection images.  

3.2 X-ray optics alignment 

In this procedure, it is assumed that approximate aligned positions of each component are 
known, either from the direct beam location method described before or from a previous 
alignment.  

To find the old alignment images, open the Image Control set  and scroll over to the tab 
labeled “axis positions.” Locate the positions of the axis of interest, and use the motion 
controller to move the corresponding stage to the approximate aligned position. Then, perform 
minor changes to align the stage as pictured below. 

3.2.1 High-resolution (HRES) 

i. Condenser 

 
Fig. 3-6: Condenser aligned. 

 
ii. Pinhole 

 
Fig. 3-7: 1st order reflection 
isolated by 60 µµµµm pinhole. 
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iii. Zone plate 

 
Fig. 3-8: High-resolution 
zone plate aligned. 

 
iv. Bertrand lens 

  
Fig. 3-9: Bertrand lens aligned, imaged in 2X (left) and 
20X (right). 

 
Record the coordinates for the Bertrand lens aligned position here: 

Bertrand X  
Bertrand Y  
Bertrand Z  

 
v. Detector (20X) 

With the light from the Bertrand lens focused on the 2X objective and centered 
in the ring, switch to the 20X objective. If the focused ring is not in the center 
of the field of view, adjust the manual micrometers on the detector until the 
20X image appears as above.  

Tip: The pixel size on the detector is 0.65 µm using the 2X objective at 
1x1 binning. To calculate the amount the detector should be moved, 
multiply 0.65 µm by the binning, and then multiply the result by the 
number of pixels necessary to move the ring to the center. Then, shift 
the detector in x and y by the final calculated distance (each minor 
division on the micrometer represents 10 µm of motion). 
 

vi. Phase ring 



 

Fig. 3-10: Phase ring moving into the illumination (left) 
and aligned (right).

 
The phase ring, when imaged with the Bertrand lens, will appear as a shadow 
in the focused illumination. The goal of alignment is to shift this shadow using 
the phase ring motors until it completely covers the bright ring. The 
membrane contains four rings in a 200 
different size. If the first ring does not fit, shift by 200 
another is visible and try again. 
 
When phase ring alignment is complete, move the Bertrand 

optical path and, when it has completed motion, click the 
the motion controller. Then, take one image of the flat field and save it for 
future reference.
  

vii. Collect an image of the X50
In order to qualify the hi
30-7 test pattern. Throughput should be around 140 cts/min at binning 1 (for 
a clean anode and new filament), and contrast at the frequency corresponding 
to the second region from the center should be ~1
below, reference correction has also been applied.
 

Fig. 3-11: Test pattern with 50 
nm tips imaged in phase contrast. 

3.2.2 Large field-of-view (LFOV)

i. Condenser (if misaligned)

15 

  
10: Phase ring moving into the illumination (left) 

and aligned (right). Imaged with 20X objective. 

The phase ring, when imaged with the Bertrand lens, will appear as a shadow 
in the focused illumination. The goal of alignment is to shift this shadow using 
the phase ring motors until it completely covers the bright ring. The 
membrane contains four rings in a 200 µm x 200 µm grid, each with a 
different size. If the first ring does not fit, shift by 200 µm in x and/or y until 
another is visible and try again.  

When phase ring alignment is complete, move the Bertrand lens out of the 

optical path and, when it has completed motion, click the 
the motion controller. Then, take one image of the flat field and save it for 
future reference. 

Collect an image of the X50-30-7 test pattern 
In order to qualify the high-resolution alignment, collect an image of the X50

7 test pattern. Throughput should be around 140 cts/min at binning 1 (for 
a clean anode and new filament), and contrast at the frequency corresponding 
to the second region from the center should be ~14%. In the image shown 
below, reference correction has also been applied. 

 
11: Test pattern with 50 

nm tips imaged in phase contrast.  

view (LFOV) 

Condenser (if misaligned) 

The phase ring, when imaged with the Bertrand lens, will appear as a shadow 
in the focused illumination. The goal of alignment is to shift this shadow using 
the phase ring motors until it completely covers the bright ring. The phase ring 

m grid, each with a 
m in x and/or y until 

lens out of the 

 button in 
the motion controller. Then, take one image of the flat field and save it for 

resolution alignment, collect an image of the X50-
7 test pattern. Throughput should be around 140 cts/min at binning 1 (for 

a clean anode and new filament), and contrast at the frequency corresponding 
4%. In the image shown 
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Fig. 3-12: Condenser aligned. 

 
ii. Pinhole 

 
Fig. 3-13: 1st order reflection 
isolated by 150 µµµµm pinhole. 

 
iii. Zone plate 

 
Fig. 3-14: Large field-of-view 
zone plate aligned. 

 
iv. Bertrand lens 

 
[example picture needed] 

 
Record the coordinates for the Bertrand lens aligned position here: 

Bertrand X  
Bertrand Y  
Bertrand Z  

 
v. Phase ring 
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Fig. 3-15: Phase ring moving into the illumination (left) 
and aligned (right). Imaged with 2X objective. 

 
vi. Collect an image of the X50-30-7 test pattern. 

As before, collect an image of the X50-30-7 test pattern to qualify alignment. 
Throughput should be ~700 cts/min at binning 1 for a single zone plate, and 
contrast ~ 7% for the third region from the center. 
 

 
Fig. 3-16: Test pattern with 50 nm tips 
imaged in large field of view with Zernike 
phase contrast. 

 

 

NOTE: A small z shift is necessary between HRES and LFOV zone plate configurations. 
Refer to Table 2-1 for the proper placement of these optics relative to the sample (for 
use during installation), and then refer to old images (after installation) for the proper 
positions relative to home. 

3.3 Standard alignment correction procedure 

During the course of normal operation, the system alignment may drift slightly, prompting a 
need for performing small corrections. The procedure for checking and correcting for these 
drifts is outlined here. To ensure optimal operation of nanoXCT, it is recommended that the 
alignment be checked at least once per week, and always before a long tomography set is 
started.  
 

1. Switch to the 2X objective. 
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Fig. 3-17: Images from a system in which the alignment has drifted. On 
the left is an image taken with the 20X objective, and the right with 2X. 

 
2. If the phase ring is inserted, use the incremental motion function to move it 2500 µm 

toward zero. 
3. Remove the zone plate by using the incremental motion function to move it 5000 µm 

toward zero. 
4. Remove the pinhole by using the incremental motion function to move it 3000 µm 

toward zero. 
5. Check the alignment of the condenser. If it does not appear aligned per the figures in 

the previous section, perform small motions until it is realigned.  
 

 
Fig. 3-18: Condenser is misaligned by 
approximately 30 µm in the Y direction. 

 
6. Move the pinhole back in by using the incremental motion function to move it 3000 µm 

away from zero. Perform small motions until it is realigned per the figures in the 
previous section. 

7. Move the zone plate back in by using the incremental motion function to move it 5000 
µm away from zero. Perform small motions until it is realigned per the figures in the 
previous section. 

8. If phase contrast is desired:  
a. Move the Bertrand lens back in by using the incremental motion function to 

move it to its aligned position. Perform small motions until it is realigned per 
the figures in the previous section. 

b. Move the phase ring back in by using the incremental motion function to move 
it 2500 µm away from zero. Perform small motions until it is realigned per the 
figures in the previous section. 

9. Take one image of the flat field and verify that the FOV is detected as expected. If it is 
severely off-center, use the manual micrometers on the detector box to perform very 
small motions until it is recentered. 

10. Open Microscope->Configure System, click on the Energy tab, and enter the 
appropriate configuration information into the fields (8 keV for high-resolution, 8.1 keV 
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for large field of view, selecting absorption or phase contrast as appropriate). Then, 
click “Store Current positions to energy table” and click OK. If asked to want to move 
motors, click “no.” 
 

 
Fig. 3-19: Energy table settings window. 

 
11. Switch back to the 20X objective. 

 



 20 

Chapter 4: Motion Controller 

4.1 Introduction 

TXMController offers control over each motorized axis available in nanoXCT. Motion may be 
executed either to an absolute motion or incrementally, and the details of the controller are 
outlined below. 

4.2 Motion Controller Functions 

The motion controller may be launches by clicking the motion controller button . The 
functions are explained below. 
 

 
Fig. 4-1: Motion controller window. 

 
1. Stage selection tabs 

At the top of the motion controller window, a variety of tabs are present, one for each 
stage. Select the appropriate tab to reveal controls for each of the available motors on 
the stage. 
 

2. Stop all motors button  
By clicking the stop all motors button, all axes become disabled, meaning that power 
is no longer sent to any motor and all motion is halted. It is recommended, as general 
practice, to keep all motors disabled when not in use. 
 

3. Stop axis button  
The stop axis button has similar functionality to the stop all motors button, but only 
applies to a single axis. If, for example, many axes are moving but only one needs to 
stop, clicking this button will allow the others to continue moving.  

 
4. Absolute motion field  

The absolute motion field allows the user to move the selected axis to a specified 
position in microns. To perform this type of motion, type the desired position in the 
field to the left and click GO. 
 

5. Motor speed selection  
The motor speed selection slider allows control over the speed at which the specified 
motor will move. With the slider all the way to the right, motion will execute at the 

Stage selection 

Stop all motors 
button 

Step size 

Increment 
button 

Decrement 

Stop axis 
button 

Absolute 
motion field 

Motor 
status Motor 

speed 

Home 

Zero 
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maximum rate, and setting the slider all the way to the left will not perform any 
motion. Reducing the speed will increase the precision of motion, but will also increase 
the wait time for the motor to reach its position. For general purposes, it is 
recommended to keep this set at 100%. 
 

6. Step size field  
The step size field allows the user to specify the distance, in microns, to move the 
specified axis during incremental motion. 

 
7. Increment/decrement buttons /  

The increment/decrement buttons execute relative motion by the amount specified in 
the step size field.  
 

8. Home button  
The home button executes the homing routine for the specified axis along with all of 
its dependencies. See the section on motor homing (Appendix A) for more information 
on this feature. 

 
9. Zero button  

The zero button sets the current position of the specified axis to zero, and stores the 
relative distance from home in a separate location. When motors are re-homed, they 
will return to the zero position by default. 
 

10. Motor status window  
The motor status window provides updated information on the status of the specified 
motor. It will report if the motor is enabled or disabled, as well as any travel limits 
encountered. 
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Chapter 5: Pre-alignment microscope 

5.1 Introduction 

To ease the location of samples and regions of interest (ROIs), the nanoXCT is equipped with 
an auxillary visible-light microscope, called the pre-alignment microscope (PAM). The 
microscope has two illuminators, two objective lenses, and a sample stage that is calibrated 
during setup to the nanoXCT (see Appendix A for calibration procedure).  
 

 
Fig. 5-1: Pre-alignment microscope. 

5.2 Illumination 

The pre-alignment microscope includes two fiber-optic illuminators, to provide both 
transmission- and reflection-mode illumination.  

5.3 Objective lenses 

Two objective lenses are included with the pre-alignment microscope, with 10X and 50X 
magnification. An objective shifter is also installed to easily switch between the two objective 
lenses. 

5.4 Sample lock/unlock & micromanipulators 

On the corner closest to the monitor, a black switch is positioned to unlock and re-lock the clip 
on the chip sample holder. With the chip unlocked, the Si-tip micromanipulator may be used 
to physically reposition the sample on the sample holder. 

5.5 Monitor, crosshair generator, & CCD camera 

The pre-alignment microscope includes a TV monitor and crosshair generator for viewing the 
output from the CCD camera. The crosshair generator must be turned on in order to view the 
image. 

5.6 Operation procedure 

1. With the red handle pointing away from the sample stage, position the sample holder 
so that the three balls on the stage fit into the matching grooves on the sample 
holder. With the sample firmly supported, flip the lever so that it points toward the 
sample. The magnet in the sample stage should now sufficiently support the sample 
holder. 

2. Turn on the TV monitor and set it to VIDEO mode. Turn on the crosshair generator. 
3. Turn on the appropriate illuminator and tune the illumination to a reasonable level. 
4. Switch to the 10X objective. Using the sample stage micrometers, position the sample 

so that the ROI is clearly visible in the center of the crosshairs. Switch to the 50X 
objective, and perform fine tuning. 

Transmission mode 
illuminator 

Reflection mode 
illuminator 

10X objective 

50X objective Sample stage 

Micromanipulator 

Crosshair generator Monitor 

Sample 
lock/unlock switch 

Objective shifter 
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5. If the sample is in the clip-style holder and far from zero in the x-direction, unlock the 
clip using the black switch and use the micromanipulator to reposition the sample. 
Then, repeat step 4 until the ROI is again centered. 

6. Write down the coordinates from the digital micrometers and reverse step 1 to remove 
the sample holder. Place in nanoXCT and move the sample stage to the noted 
positions.



 

Chapter 6: Collecting 2D Images

6.1 Introduction 

Xradia’s TXMController software package enables several different modes of 2D image 
collection. A brief description of each mode is given in this section. To launch the 

Mode dialog, click the corresponding icon 

6.2 Camera Settings 

In the acquisition mode, camera settings must be specified for each imaging mode. The 
available parameters are as follows:

1. Exposure time 
The exposure time is the length of time that the CCD will be exposed during the 
collection of each image. The total number of counts has a linear dependence on 
exposure time, meaning that a longer exposure time will increase the signal
ratio of the resulting image

2. Binning 
The binning value controls the effective CCD size in pixels. A binning value of 
sum the reading of n2 adjacent pixels, increasing the total number of counts by the 
same factor. While this quickly increases signal
limits the resolution of the system, and must be used with caution.

3. Readout time 
The readout time of the CCD represents the amount of time the camera spends 
reading data from the chip. The 
but may take as long as 10 seconds for images collected at binning 1; 
readout, by contrast, takes only a few seconds, but comes with a slight increase in 
noise level. For images with >2000 counts on average or where image quality is not 
critical, fast mode is usually sufficient. 

6.3 Typical imaging times

Imaging times are highly sample dependent. The camera used in nanoXCT has a 16
however, so a general minimum, in practice, is ~2000 counts for acceptable statistics. For 
low-density samples (i.e., minimal x
 

~300s at binning 2 for the high
~180s at binning 1 for large field
 

Naturally, these times are simply general guidelines, and will change depending on the 
properties of the material being imaged. For expected x
is often useful to consult the X-
National Laboratory at: 
 

http://henke.lbl.gov/optical_constants/filter2.html
 
Be sure to reference the photon energy specific for the nanoXCT laboratory tool in use (8000 
eV for a copper target, 5400 eV for chromium).

6.4 Aborting image acquisition

To halt the image acquisition at any time, click the stop icon 

6.5 Acquisition modes 

6.5.1 Single 

In single image mode, one image only is collected according to the camera settings. 
The image is stored in memory and displayed on the 
manipulate.  
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Chapter 6: Collecting 2D Images 

Xradia’s TXMController software package enables several different modes of 2D image 
collection. A brief description of each mode is given in this section. To launch the 

the corresponding icon  in the toolbar.  

In the acquisition mode, camera settings must be specified for each imaging mode. The 
available parameters are as follows: 

is the length of time that the CCD will be exposed during the 
collection of each image. The total number of counts has a linear dependence on 
exposure time, meaning that a longer exposure time will increase the signal
ratio of the resulting image. 

value controls the effective CCD size in pixels. A binning value of 
adjacent pixels, increasing the total number of counts by the 

same factor. While this quickly increases signal-to-noise and decreases fil
limits the resolution of the system, and must be used with caution. 

of the CCD represents the amount of time the camera spends 
reading data from the chip. The precision readout mode produces very clean images, 
but may take as long as 10 seconds for images collected at binning 1; fast
readout, by contrast, takes only a few seconds, but comes with a slight increase in 
noise level. For images with >2000 counts on average or where image quality is not 

fast mode is usually sufficient.  

6.3 Typical imaging times 

Imaging times are highly sample dependent. The camera used in nanoXCT has a 16
however, so a general minimum, in practice, is ~2000 counts for acceptable statistics. For 

mples (i.e., minimal x-ray absorption), this translates to: 

~300s at binning 2 for the high-resolution configuration 
~180s at binning 1 for large field-of-view 

Naturally, these times are simply general guidelines, and will change depending on the 
ies of the material being imaged. For expected x-ray absorption of known materials, it 

X-ray Interactions with Matter calculator from Lawrence Berkeley 

http://henke.lbl.gov/optical_constants/filter2.html 

Be sure to reference the photon energy specific for the nanoXCT laboratory tool in use (8000 
eV for a copper target, 5400 eV for chromium). 

6.4 Aborting image acquisition 

To halt the image acquisition at any time, click the stop icon  on the main toolbar.

In single image mode, one image only is collected according to the camera settings. 
The image is stored in memory and displayed on the screen for the user to 

Xradia’s TXMController software package enables several different modes of 2D image 
collection. A brief description of each mode is given in this section. To launch the Acquisition 

In the acquisition mode, camera settings must be specified for each imaging mode. The 

is the length of time that the CCD will be exposed during the 
collection of each image. The total number of counts has a linear dependence on 
exposure time, meaning that a longer exposure time will increase the signal-to-noise 

value controls the effective CCD size in pixels. A binning value of n will 
adjacent pixels, increasing the total number of counts by the 

noise and decreases file size, it also 

of the CCD represents the amount of time the camera spends 
readout mode produces very clean images, 

fast mode 
readout, by contrast, takes only a few seconds, but comes with a slight increase in 
noise level. For images with >2000 counts on average or where image quality is not 

Imaging times are highly sample dependent. The camera used in nanoXCT has a 16-bit depth, 
however, so a general minimum, in practice, is ~2000 counts for acceptable statistics. For 

Naturally, these times are simply general guidelines, and will change depending on the 
ray absorption of known materials, it 

calculator from Lawrence Berkeley 

Be sure to reference the photon energy specific for the nanoXCT laboratory tool in use (8000 

on the main toolbar. 

In single image mode, one image only is collected according to the camera settings. 
screen for the user to 
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Single acquisition may be started directly by clicking on the still camera button  in 
the main toolbar. The settings used will be identical to the previous single image 
collection. 
 

 
Fig. 6-1: Single acquisition mode. 

6.5.2 Continuous 

In continuous mode, images are collected according to the camera settings and 
continuously updated on the screen. This action takes place inside a single display 
window, meaning that every new image overwrites the previous.  
 
Continuous acquisition may be started directly by clicking on the video camera button 

 in the main toolbar. The settings used will be identical to the previous continuous 
image collection. 
 

 
Fig. 6-2: Continuous acquisition mode. 

6.5.3 Mosaic 

Mosaic imaging mode allows the collection of multiple images at different locations, 
which are automatically stitched together into one single image. This provides the 
ability to see a large region of the sample, in order to easily locate a region of interest. 
Mode-based settings for mosaic imaging are as follows: 

1. Fast axis 
The fast axis is moved most frequently in a consecutive manner, and is 
represented on the final mosaic image as the horizontal axis. 

2. Slow axis 
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The slow axis is moved only after each complete row has been collected, and 
is represented on the final mosaic image as the vertical axis. 

3. Fast axis center (um) 
The fast axis center is the position, in microns, about which the fast axis will 
move. 

4. Slow axis center (um) 
The slow axis center is the position, in microns, about which the slow axis will 
move. 

5. Fast axis step (um) 
The fast axis step specifies the amount of motion to be performed by the fast 
axis between each successive tile. 

6. Slow axis step (um) 
The slow axis step specifies the amount of motion to be performed by the slow 
axis after each complete row of tiles has been collected. 

7. No of Mosaic Rows 
The no of mosaic rows specifies the total number of images to collect along the 
slow axis direction. 

8. No of Mosaic Columns 
The no of mosaic columns specifies the total number of images to collect along 
the fast axis direction. 

 
NOTE: For mosaics greater than 3x3, it is recommended to use binning 4 or 8, as 
memory consumption at binning 1 or 2 can become large enough to impact general 
performance of the computer workstation. 
 

 
Fig. 6-3: Mosaic acquisition mode. 

 

 
Fig. 6-4: 7x7 mosaic of a plastic zone 
plate imaged in phase contrast. 

One FOV 
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6.5.4 Focal Series 

In focal series mode, the motor selected in the mode-based settings is moved along its 
axis, stopping at discrete intervals for image collection, resulting in a file containing a 
series of images. The typical application for this mode is to move a z-axis motor, such 
as sample z, across a small image to determine the position of best focus. Mode-based 
settings for focal series collection are as follows: 

1. Motor 
One the right side of the mode-based settings window, the motor to be used in 
the focal series must be chosen. The most typical axis used in focal series 
acquisition is sample z. 

2. Center Z position (um) 
The center z position specifies the location about which the specified axis will 
be moved. 

3. Range (um) 
The range is the total amount of motion that will be executed during collection. 
Motion is executed from center-range/2 to center+range/2. 

4. No of Images 
The no of images specifies the total number of images that will be collected 
during the focal series. The step size of the motor for each image is the 
quotient of range and number of images.  

 

 
Fig. 6-5: Focal series acquisition mode. 

6.5.5 Averaging 

To increase the overall signal-to-noise ratio of the final image, many images may be 
collected and then averaged together. While the signal remains roughly constant, the 
random noise is reduced, leading to a cleaner, clearer image. The software may do the 
averaging while doing the acquisition, or the task of averaging may be left to the user 
to perform after the fact. This feature is useful for collecting clear images of a single 
angular projection as well as collecting a flat-field image for reference correction.  

 
The mode-based settings are as follows: 

1. No of Images 
2. Average images on fly 

The average images on fly option, when checked, averages images as they are 
collected, resulting in a single, averaged data file. If it is left unchecked, the 
resulting file is a file containing a set of all the individual images, where 
averaging is left to the user to perform using the alignment tab in the image 

control set window. 
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Fig. 6-6: Averaging acquisition mode. 

 

  
Fig. 6-7: Single image (left) and 10 images averaged (right). 

 
For collecting averaged data, the recommended procedure is as follows: 

i. Collect the averaging series, not averaging on the fly. 
ii. Collect an averaged reference with ~50% more counts than the data 

set (averaging on the fly is ok). 
iii. Apply the reference to the averaging series. 
iv. Average the data. 
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Chapter 7: Collecting 3D Tomography Data 
 
In this section, a procedure is outlined for collecting a set of tomography data. High-contrast 
metal foam is used as the example, and data is collected up to ± 90° (i.e., full 180° rotation) in 
the large field-of-view configuration. It is assumed that the rotation axis aligned has already 
been completed and the nanoXCT and pre-alignment microscope are properly aligned to each 
other and the rotation axis. 

7.1 Preparing the sample 

1. Load the sample into the holder and place into the pre-alignment microscope (PAM). 
2. Center the feature of interest in the PAM crosshairs using the 50X objective lens and 

note the X/Y/Z positions of the micrometers. 
3. Remove the sample from the PAM and place it into the nanoXCT (NCT). 

7.2 Initial alignment 

1. Position the NCT sample X/Y/Z motors to match the location found using the PAM.  
2. Collect a single image. 
3. If the image collected does not match the feature found using the PAM, perform a 

small mosaic (e.g., 3x3 for large field-of-view and 5x5 for high-resolution 

configuration). Once the feature of interest has been located, use the drive to  
feature of TXMController to move the sample stage to that location. Once the feature 
has been located, collect a single image for record keeping. 

7.3 Preparing for tomography with software stage correction 

1. Navigate to Microscope->Configure System to open the System Configure window. 
 

 
Fig. 7-1: Location of Configure System 
option under the Microscope menu. 

 
2. Check the box next to Apply stage correction. Then, set X Correction to the current 

sample X position and Z Correction to -1 * current sample Z position. When finished, 
click OK to close the window. 
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Fig. 7-2: System Configure window. 

 

3. Open the Acquisition Mode window  and select Tomography. Set the start angle to 
something small, such as -20° for large field-of-view imaging, and set the end angle to 
be symmetric about 0° (e.g., +20°). Set the number of steps to 7, and the imaging 
time and binning to a quick, coarse value. Then, begin acquisition. 

 

 
Fig. 7-3: Tomography mode window. 

 

4. When the data set has finished collection, open the Image control set menu  and 
navigate to the Alignment tab. Click Manual mode, and then select image #4, 
corresponding to 0°. In the data set, double-click on the feature that is being aligned 
to the rotation axis. Repeat for image #3, 2, and 1 to track this feature through the 
projection images. Then, move to image #5 and repeat through #7. When finished, 
click Stage Calibration and then select OK in the resulting prompt window. 

 

1. Check box 2.  X Correction = Sample X 
 Z Correction = -1*Sample Z 



 

 
5. Iterate steps 3 and 4 with increasing angular range and number of images until the 

apparent image shifts are almost zero and the range covers all an
for tomography in 10° 

7.4 Collect the tomography data

Begin collecting a final tomography set, collecting over as large of an angular range as 
possible with 1° steps. Set the exposure time and camera binning such that >2000 
counts are observed and the necessary resolution is achieved (increase binning by a 
factor of two increases effective throughput by a factor of four, but decreases 
resolution by the same amount). 
 
In this example, data is collected from 

7.5 Collect a reference & correct the tomography data set

Move the sample out of the x
stage or physically removing the sample holder from NCT. The collection mode should 
be Averaging of at least 5 images (10 is recomm
should match the tomography data set
be selected.  
 

 
When collection of the reference is complete, 
by 1.5. Then, save the new multiplied image as a new file. S
set, open the Image Control Set
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Fig. 7-4: Aligning the data set. 

Iterate steps 3 and 4 with increasing angular range and number of images until the 
apparent image shifts are almost zero and the range covers all angles that will be used 

 steps. 

7.4 Collect the tomography data 

Begin collecting a final tomography set, collecting over as large of an angular range as 
steps. Set the exposure time and camera binning such that >2000 

unts are observed and the necessary resolution is achieved (increase binning by a 
factor of two increases effective throughput by a factor of four, but decreases 
resolution by the same amount).  

In this example, data is collected from -90° to +90°, with 181 total images.

7.5 Collect a reference & correct the tomography data set 

Move the sample out of the x-ray beam by either using the motors on the sample 
stage or physically removing the sample holder from NCT. The collection mode should 

t least 5 images (10 is recommended), exposure time and binning 
should match the tomography data set.  For ease of use, Average images on fly

 
Fig. 7-5: Averaging mode window. 

When collection of the reference is complete, open the image calculator and multiply it 
by 1.5. Then, save the new multiplied image as a new file. Select the tomography data 

Image Control Set window, and navigate to the Reference tab. Browse 

Iterate steps 3 and 4 with increasing angular range and number of images until the 
gles that will be used 

Begin collecting a final tomography set, collecting over as large of an angular range as 
steps. Set the exposure time and camera binning such that >2000 

unts are observed and the necessary resolution is achieved (increase binning by a 
factor of two increases effective throughput by a factor of four, but decreases 

181 total images. 

ray beam by either using the motors on the sample 
stage or physically removing the sample holder from NCT. The collection mode should 

ended), exposure time and binning 
Average images on fly may 

e calculator and multiply it 
elect the tomography data 

tab. Browse 
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for the averaged, multiplied reference image, then select Apply background 
adjustment. Finally, save the tomography data set. 
 

 
Fig. 7-6: Reference correction dialog box. 

 

  
Fig. 7-7: Tomography data with no reference correction (left) 
and reference correction applied (right).  

7.6 Align the tomography data 

Follow the same procedure as in step 4 of section 7.3 to track the alignment feature 
through each of the projections. When finished, save the data set. 



 

Chapter 8: Reconstructing 3D CT Data
 
After collecting a tomography data set with TXMController, 
generate the 3D reconstructed data set. The procedure is outlined below.

8.1 Reconstruction Procedure

1. Close the tomography data file in TXMController if it is open.
2. Open TXMReconstructor, and use it to open the file containi

The bright box around the data represents the region of the data that will be 
reconstructed, corresponding to the 2D region present in all projections (the rest is 
cropped off due to alignment).

3. Open the Reconstruction Setting
 

4. Browse  to select the output file name.
5. For best results, the following settings are recommended:
 

Center Shift (pixels)
Output data type
Binning
Beam hardening constant
Remove ring 

Shift rotation angles by
Apply CTScale
Byte scaling
Apply reconstruction filter

 
6. Click OK to close the Reconstruction Setting

7. Begin the reconstruction 
about 5 minutes to complete.  
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Chapter 8: Reconstructing 3D CT Data 

After collecting a tomography data set with TXMController, TXMReconstructor may be used to 
generate the 3D reconstructed data set. The procedure is outlined below. 

8.1 Reconstruction Procedure 

Close the tomography data file in TXMController if it is open. 
Open TXMReconstructor, and use it to open the file containing the collected data set. 
The bright box around the data represents the region of the data that will be 
reconstructed, corresponding to the 2D region present in all projections (the rest is 
cropped off due to alignment). 

Reconstruction Setting window . 

Fig. 8-1: TXMReconstructor 

 

to select the output file name. 
For best results, the following settings are recommended: 

Center Shift (pixels) 0 
Output data type FLOAT (32 bit) 
Binning 1 
Beam hardening constant 0 
Remove ring artifacts No 

Shift rotation angles by 0 deg 
Apply CTScale No 
Byte scaling No (auto) 
Apply reconstruction filter Yes 

Reconstruction Setting window. 

Begin the reconstruction . Reconstruction will begin immediately, and usually takes 
about 5 minutes to complete.   

TXMReconstructor may be used to 

ng the collected data set. 
The bright box around the data represents the region of the data that will be 
reconstructed, corresponding to the 2D region present in all projections (the rest is 

 

. Reconstruction will begin immediately, and usually takes 
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Chapter 9: Viewing and Exporting Reconstructed Data 

9.1 Viewing data 

9.1.1 Opening a reconstructed volume 

3D reconstructed data is generally viewed in TXM3DViewer, available via the Microsoft 
Windows Start menu. Launch the program and open the reconstructed volume using 
the File->Open dialog.  
 
Some large files (those reconstructed at binning 1, for example) are too large to fit in 
the computer’s memory. In this case, a prompt is shown asking about the method to 
be used for opening the file. It is recommended to use out-of-core mode here, which 
writes another file to disk storing all of the temporary information. These files are 
quite large, and may be deleted or omitted from backup routines after closing the 
program. 
 

 
Fig. 9-1: Large TXM file load prompt. 

9.1.2 Layouts 

Many view options are available in the main window. There are four standard view 
modes, shown below. 
 

 
Fig. 9-2: Layout toolbox. 

 

 2D slice layout 

  
Fig. 9-3: Example of 2D slice layout. 
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 Simultaneous slice & volume layout 1 (default) 

   
Fig. 9-4: Example of simultaneous 
slice & volume layout 1. 

 

 Simultaneous slice & volume layout 2 

   
Fig. 9-5: Example of simultaneous 
slice & volume layout 2. 

 

 3D volume layout 

  
Fig. 9-6: Example of 3D volume 
layout. 

9.1.3 Mouse mode 

The mouse mode options allow selection of several different mouse effects.  
 

 
Fig. 9-7: Mouse mode toolbox. 

 

 Navigation – Clicking and dragging navigates through slices or moves the 
volume rendering 

 Pan – Clicking and dragging pans the selected view 

 Contrast – Clicking and dragging dynamically changes contrast 

 Annotation – Clicking on a point in one view applies an annotation 
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 Measurement – Clicking on two points in a view measures the distance 
between the points 

9.1.4 Options 

 

 
Fig. 9-8: Options toolbox. 

Navigation modes 

 Navigate through the slices in orthogonal (XYZ) mode 

 Navigate through the slices in oblique (arbitrary angle) mode 

Extra information 

 Display axis & slice number information on the slices 

 Display a 3D box on the volume rendering for orientation information 

Capture 

 Capture the current view to be exported into the report (see section on 
exporting) 

Zoom 

Use the increment/decrement buttons and/or percentage control to zoom the 
current view by a specified amount. 

Thickness 

Adjust the thickness slider to integrate several slices into each view. For noisy 
reconstructions, it is often helpful to increase this slider by a small amount to 
reduce the noise and smooth out the images. 

9.1.5 Cropping 

 
Fig. 9-9: Crop toolbox. 

 
By cropping the reconstruction in slice view, it is possible to eliminate regions of pure 
noise to keep them from contributing to the volume rendering. Several different 
cropping modes are available: 

 No cropping 

 Orthogonal (XYZ) cropping 

 Orthogonal (XYZ) corner cropping 

 Oblique (arbitrary angle) corner cropping 

 Oblique (arbitrary angle) cropping 
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9.1.6 3D display modes 

 
Fig. 9-10: 3D display mode toolbox. 

 
Several different modes of 3D display are available: 

MPR – Multi planar rendering. This mode displays the 2D slices as planes in 
3D space.  
MIP – Maximum intensity projection. Using a technique similar to the thick 
slice rendering, the projection chooses the brightest voxel along each viewing 
ray in the 3D window. As a result, the 3D object appears ghostlike, but three-
dimensional 
VRT – Volume rendering technique. Similar to MIP, this mode computes a 2D 
projection from all the data values in 3D. A color and transparency mapping, 
called transfer function, is applied to each voxel, determining the amount that 
is visible “behind” a voxel. 
SVRT – Shaded volume rendering technique. This mode is similar to VRT 
mode, but adds virtual “shading” from a virtual light source. This shading adds 
highlights, such that curvature differences or small “bumps” on smooth 
surfaces can be easily detected 
SSD – Shaded surface display (iso-surface). This rendering mode is useful for 
extracting structures that are mapped to a specific range of intensity values in 
the data. SSD does not use a color/transparency mapping as VRT and SVRT 
do, but a single threshold value that is used to define a virtual surface that 
represents that value in the data. 

 
VRT is typically used for most cases, but SSD can be useful for low-noise, high-
contrast images where surface rendering is important. 

9.1.7 Data window, transfer function, fade, and color 

Changing the transfer function and fade parameters for the 3D volume or the data 
window parameters for the slices will alter the appearance of the data. To change a 
parameter, click the appropriate slider and drag it to the desired position. The 
appearance image will change in real time. 
 

 

 
(a) Data window threshold 

parameters (for slices) 
(b) Transfer function and fade 

parameters (for volume) 
 

Fig. 9-11: Data window (a) and transfer function(b) toolboxes. 

 
The transfer function window allows some additional control, over both the color and 
the opacity function governing the effect of the fade slider. 
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Data window 

Changing the data window sliders will alter the viewed dynamic range of the 
slices. 
 

 

 

 

 

 

 
Fig. 9-12: 2D slice effects of adjusting the data window sliders. 

Transfer function 

Changing the transfer function sliders will alter the viewed dynamic range in 
the 3D volume rendering. 
 

 

 

 

 

 

 
Fig. 9-13: 3D volume effects of adjusting the transfer function sliders. 

Fade 

Changing the fade slider will alter the threshold of the coloring. 
 

 

 

 

 

 

 
Fig. 9-14: 3D volume effects of adjusting the fade slider. 

Color 

Changing the color parameter will change the color spectrum used to fill in the 
3D volume rendering.  
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Grey ramp 

 
Hue ramp 

 

 
Hot iron 

 

 
Glow 

 

 
Organic 

 

 
Temperature 

Fig. 9-15: 3D volume effects of changing the color scheme. 

9.2 Exporting data 

There are three techniques to exporting data. The first involves using TXM3DViewer to export 
an animated video file, the second to export a report of single slices to Microsoft Word, and 
the third uses TXMController to manipulate and export. 

9.2.1 MPEG video files from TXM3DViewer 

In the 2D slice  or 3D volume  layout mode, the cine options toolbox is enabled, 
allowing the preview and export of slice and volume animations as MPEG (*.mpg) files.  
 

 
Fig. 9-16: Cine controls toolbox (active 
only in 2D or 3D view). 
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Clicking the play button  will begin the animation, and window settings may be 
adjusted on the fly. To export the animation, click the save icon  in the bottom left 
corner, launching the cine options window. 
 

 
Fig. 9-17: MPEG export options. 

 
The options available are as follows: 

MPEG Options 

Frames per second – Specifies the frame rate for the resulting MPEG file. 
Number of frames – Controls the total number of frames for the resulting 
MPEG file. The time length of the video will be computed as the number of 
frames divided by the frame rate.  
Image size – Specifies the size, in pixels, of the exported images. 

3D Volume Animation 

Rotation axis – Specifies the axis to be used for rotation (3D volume export 
only). The software may be allowed to calculate the most vertical axis for 
rotation, the user may specify one axis in particular, or an arbitrary vector 
may be defined. 

2D Slice Animation 

Slice range - Specifies whether to include all slices in the export or to restrict 
to a certain range. 

 
Accepting all of the default values is typically sufficient. 
 
When finished selecting options, click OK and select the location in which to save the 
file. Then, click OK again to begin the export. 
 
NOTE: The workstation must be left alone during the export process! The export 
routine works through a system of screenshots, and opening any other windows will 
cause empty frames to be inserted in the exported file.  

9.2.2 DOC reports from TXM3DViewer 

If single slices are desired for export, TXM3DViewer offers an automatic report 
generation routine, which will insert them into a Microsoft Word (*.doc) document. To 
capture single images, follow the procedure below: 
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1. Select the camera icon  from the options toolbox. 
2. Click on the desired slice or volume view. Note that annotations (such as 

measurements, text notes, scale bar, etc.) will be captured as well. 
3. Repeat steps 1 & 2 for each additional view.  
4. Click on the report tab at the bottom of the viewer window. All of the captured 

images should be in the snapshots toolbox at the left of the screen. 
 

 
Fig. 9-18: Report generation utility. 

 
5. Select the desired output template from the templates toolbox at the upper 

left corner of the report window.  
 

 
Fig 9-19: Report template toolbox. 

 
6. Click on the first image from the snapshots toolbox and drag it into the main 

window. Add notes, if desired, using the text box at the bottom of the screen. 
7. To add an additional page (e.g., for another image), click the insert page 

 button at the bottom of the screen, and select the tab corresponding to 
the new page (at the top of the window).  

8. Iterate steps 6 and 7 until all images desired for export have been included. To 
clear images from the snapshots toolbox, click the clear button ; to 
delete a page, click the remove page button . 

9. When finished, click the export button  to launch Microsoft Word with 
the new report imported. The images may be moved to other applications 
using standard copy-and-paste techniques. 

9.2.3 AVI & Image files from TXMController 

The reconstructed files (*.txm) may also be opened in TXMController, which will 
display the XY slice view. 

Writing XZ & YZ planes 

Navigate to Process->Write two other planes. 

Single slices 

Use the functionality in File->Save as… (described in detail in the next chapter). 
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Animated video file  

Navigate to File->Create AVI… and use the on-screen dialog. The available options 
are similar to those in the TXM3DViewer MPEG creation routine.
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Chapter 10: Extended Functions of TXMController 
 
In this section, several of the most commonly used “extended functions” of TXMController are 
described.  

10.1 Changing objective lens magnification 

As mentioned earlier, the detector uses two objectives: 2X magnification for alignment and 
20X for imaging. These objectives are on a motorized shifting mechanism, and may be 
changed by selecting the proper lens from the magnification change icon in the main toolbar: 
 

 
Fig. 10-1: Magnification change dialog. 

10.2 Reference correction 

After collecting an image or image series, it is generally beneficial to apply a reference image 
to normalize the data for effects contributed by the beam and detector. Reference images 
must be of the same or lower binning as the set to be normalized, and the count rate of the 
reference image should be greater. To minimize the chance of injecting noise into the 
normalized data, it is recommended to take at least five reference images and average. 
 

To apply reference correction, open the image control set toolbox  and navigate to the 
Reference tab. Click the Browse… button, and select the single (preferably averaged) 
reference image. Then, click Apply Correction to perform normalization. If more images will be 
collected with the same parameters in the same configuration, select the Keep last file when 
there is no reference checkbox, and the reference file will be associated with all future images 
as well. 
 

 
Fig. 10-2: Reference correction window. 

 
Specific options are as follows: 

1. Keep last file when there is no reference 
Enabling the keep last file when there is no reference checkbox makes the current 
reference file persistent, and stores it with all future image collections. Reference 
correction is not automatically applied, however, and the apply correction checkbox 
must still be selected in future images. 
 

2. Apply background adjustment 
The apply background adjustment scales the amount of CCD dark current 
normalization to adjust for changes based on the value specified in TXMConfigure. It is 
generally not used, and should be left unchecked. 
 

3. Reference file 
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a. Browse… 
The browse button opens a file browser window to select the reference file. 

b. Show 
The show button displays the stored reference image on the screen in a new 
data window. 
 

4. Transmission/Absorption 
By selecting the default transmission mode normalization, the current image is divided 
by the reference image. In absorption mode, the logarithm of the transmission mode 
normalization is taken, inverted, and then multiplied by -1. The result of transmission 
mode is a normalized image where x-ray absorption is visible as dark regions, and the 
opposite is the case in absorption mode. 
 

5. Apply Correction 
Selecting the apply correction checkbox applies the normalization to the current 
image. 
 

6. Delete existing reference 
The delete existing reference button will remove the current reference data file from 
the image.  

10.3 Navigation through multiple-image data sets 

When a multiple-image data set is collected (e.g., tomography, averaging, focal series), there 
are two main options for navigating through the data.  

1. Data window navigation 
At the bottom of the data window, there is a slider with increment/decrement buttons 
allow quick manual navigation through the images. Drag the slider, click the +/- 
buttons, or type in an image number (and press enter) to cycle. 
 

 
Fig. 10-3: Data window navigator. 

 
2. Image control set navigation 

For automatic cycling of images, open the image control set  and navigate to the 
Navigator tab. Using this feature, the data set may be cycled automatically, playing 
like a movie through each collected image. To keep the data cycling, select the play 
continuously checkbox. 
 

 
Fig. 10-4: Image control set navigator. 

10.4 Image alignment and manual averaging 

If an averaging series is not taken with average on fly selected, the resulting set must be 
averaged using the alignment feature of TXMController. Additionally, if the sample drifts 
during the collection of an averaging series, the individual images may be manually aligned 
first, minimizing any blurring effects in the final, averaged image.  
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To manually align a data set, open the image control set toolbox  and navigate to the 
alignment tab. Under mode, select manual, and then double-click on a common point in each 
of the images in the data set. When finished, click align. Save the image if it is satisfactory or, 
otherwise, click clear shifts and repeat the alignment. 
 
To average the data (after alignment, if necessary), click the average button. If bright spots 
are observed randomly distributed throughout the data set (from high-energy x-rays colliding 
directly with the CCD), the dynamic despeckle checkbox may be selected before averaging to 
remove them.  
 

 
Fig. 10-5: Image alignment & manual averaging tool. 

10.5 Retrieving old motor positions 

TXMController stores current motor positions with each collected image. To retrieve the motor 

positions for any image, open the image control set toolbox  and navigate to the axis 
positions tab. Here, axis positions relative to zero at the time of image collection are 
displayed. By selecting the show distance from home position checkbox, absolute positions of 
each axis relative to home are displayed. If the data file contains more than one image, the 
menu at the bottom may be used to plot a graph of the position of any axis through the entire 
set. 
 



 46 

 
Fig. 10-6: Axis positions information. 

10.6 Retrieving image and exposure information 

All relevant machine and imaging parameters are stored along with each image, including 
exposure time, binning, stage correction values, and etc. To display this information, open the 

image control set toolbox  and select info. 
 

 
Fig. 10-7: Image information. 

 
To manually change the pixel size, optical magnification, or exposure time, click the edit 
button, type in a new value, and then click update. 

10.7 Exporting data 

If it is desired to open a collected image in an external program for analysis or presentation, 
TXMController offers a wide variety of exportable formats for both single- and multiple-image 
files. The available formats include BMP, JPEG, RAW TIFF, Standard TIFF, BIN, and, for 
multiple-image files, AVI.  

1. Exporting a single-image file (*.xrm) 
To convert a single-image file to another format, navigate to File->Save As and select 
the desired file type from the drop down list at the bottom of the browser window. 
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Fig. 10-8: Save as dialog for exporting a single-image file. 

 
2. Exporting a multiple-image file (*.txrm) 

If the current data file contains more than one image, it is possible to export one 
single image or the entire series. To begin, navigate to File->Save As, as in the single-
image case above. Select the desired output format from the save file as list, and then 
select whether to output the whole series or only the current image. To include 
annotations (such as the micron bar or scale bar), select the include annotations 
checkbox. In the location field, specify the directory for output and a name for the 
image series. Images will be exported in accordance with the naming convention 
given, appended with a number indicating the image number in the series. 
 

  
Fig. 10-9: Save as dialog for exporting a multiple-image file. 

10.8 Focus Function 

After collecting a focus function data set, TXMController offers an automated routine to 

determine the position of best focus. Open the image control set toolbox  and select the 
focus function tab. Select the check box corresponding to the sample type (chip for high-
contrast materials and general for most other cases), and then choose the region to examine 
(full image to examine the entire image or selected region to choose a small region only). If a 
selected region is chosen, select the linear pixel size for the region of interest and then 
double-click in the center of this region on the image. When finished, click plot focus function 
to view the calculated results. 
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Fig. 10-10: Focus function window. 

 

 

 
Image 1 

 
Image 21 

Fig. 10-11: Resulting plot of calculated focus function. 
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Chapter 11: Troubleshooting 
 
Periodic errors may be encountered when using the nanoXCT. In this section, the most 
common problems are outlined, along with typical solutions. If the problems are not solved 
using these methods, please contact Xradia for support (see Appendix E). 

11.1 Motion controller communication failure 

Symptom 

TXMController complains, “Unable to communicate with motion controller.” 

Problem 

USB communication with the motion controller has been lost.  

Solution 

There are several possible fixes, which are outlined here in the order in which they 
should be tried. As soon as the problem is fixed, proceed no further. 

1. Shut down the computer and unplug the USB cable only from the front of the 
motion controller (do not turn off the power). Wait 10 seconds, and then plug 
the USB cable back in. Start the computer workstation back up and reopen 
TXMController. 

 

 
Fig. 11-1: Location of the USB-B 
connector on the motion controller. 

 
2. The device may be “removed” and “reinserted” through the use of a software 

program. To do this, open PEWIN32PRO by navigating to Start -> All Programs 
-> PEWIN32PRO -> PEWIN32PRO. It may take up to 30 seconds for the 
program to open, so patience is the key if it appears to hang.  
 
Navigate to Setup -> General Setup and Options. 
 

 
Fig. 11-2: Navigating to General 
Setup and Options menu. 

 
Under the Default Device tab, click the box labeled Select. 
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Fig. 11-3: General Setup and Options menu. 

 
If a USB device (e.g., “USB0 – Plug and play”) is listed, click it once to 
highlight and then click Remove. This will perform a soft-removal of the USB 
device from the system.  
 

 
Fig. 11-4: PMAC Devices menu 

 
If an error is encountered in which the software asks for applications to be 
closed, click OK on the message window, close PEWIN32PRO, unplug the USB 
cable from the motion controller, and restart PEWIN32PRO. Then attempt 
device removal again. When removal is successful, plug the USB cable back in. 
 

 
Fig. 11-5: Pcomm32 error message. 

 
Click once on PMAC 00 to select it and then click Insert. In the Available PMAC 
Devices list, select Pmac USB0 (USB1 on some systems) and click OK. If no 
PMAC USBx devices are listed, restart the computer and try again. When the 
device is successfully reinserted, click OK to close the PMAC Devices window. 

 
Close all active windows. Navigate to View -> Terminal to open a new terminal 
window. If the device has been correctly initialized, the terminal should say 
Press Enter/Return to send command to PMAC. If, instead, it says Unable to 
communicate, reboot the workstation and attempt the procedure again.  
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Fig. 11-6: Launching the terminal. 

 
Alternatively, from the main screen, select Setup -> Force All Windows to 

Device Number. Click once on the device that was just reinserted to select it, 
and then click OK. This will cause all open windows to try to communicate with 
the motion controller, and any open terminal windows should display the 
message shown above. 
 
Once the device is recognized by PEWIN32PRO, close the program and reopen 
TXMController. 
 

3. As a last resort, the power to the motion controller may be reset. Note, 
however, that this will most likely result in needing to perform a complete 
system realignment.  

 
Shut down the computer workstation. Unplug the power and USB cables from 
the motion controller. Wait 10 seconds. Plug the USB cable back in and then 
plug the power cable back in. Restart the computer workstation and reopen 
TXMController. If communication has been re-established, TXMController will 
ask to re-home the motors. Remove the sample holder (if it is in) and click 
Yes.  

 

 
Fig. 11-7: Location of the 
power connector on the 
motion controller. 

 
If the motion controller is not recognized, try to reinsert it via PEWIN32PRO as 
described in the latter half of step 2. 

 
The system will now most likely be misaligned, so it will be necessary to 
perform a complete alignment. It may be helpful to open a recent aligned 
image and move the motors to that position by navigating to Microscope->Set 
motor position based on Image. This will return the system close to its aligned 
state, but it is recommended to then remove each component one by one and 
perform minor alignment adjustments per the procedure outlined in chapter 3. 
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11.2 Camera communication failure 

Symptom 

TXMController complains, “Main Camera initialization failed.” 
 

 
Fig. 11-8: TXMController 
error message when camera 
communication is lost. 

Problem 

USB communication with the CCD camera has been lost.  

Solution 

Follow this procedure: 
1. Close all programs that have potential communication with the camera (e.g., 

TXMController). 
2. Inside the NCT, turn off the power switch on the transformer box. 
 

 
Fig. 11-: Location of the power 
switch on the CCD power 
transformer. 

 
3. Unplug the USB cable from the CCD camera. 
 

 
Fig. 11-: Location of the USB-B 
connector on top of the CCD camera. 

 
4. Wait 10 seconds. 
5. Plug the USB cable back into the CCD camera. 
6. Turn the power back on. 
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7. Navigate to Start -> All Programs -> Roper Scientific -> RSConfig. Make sure 
that Camera1 registers in the Camera 1 field and click Done. If it does not, 
close RSConfig and reopen. When the camera registers, reopen TXMController. 

 

 
Fig. 11-9: RSConfig window. 

 
In the rare event that this does not fix the problem, try restarting the computer. If 
communication problems persist, try switching the camera to a different USB port on 
the computer.  

11.3 Poor/uneven image contrast 

Symptom 

The image contrast drops to low levels (e.g., <10% for the X50-30-7 test pattern) in 
some or all locations. 
 

  

  
Fig. 11-10: Phase ring aligned (top left) and misaligned 
(bottom right) with corresponding test pattern images. 
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Problem 

The phase ring has drifted out of its aligned position. 

Solution 

Move in the Bertrand lens and check the alignment of the phase ring. Reposition the 
phase ring so that it completely blocks the illumination ring. 

11.4 Poor/uneven illumination profile 

Symptom 

The illumination profile is uneven, or parts of profile are missing. 

Problem 

The system has become misaligned. Usually, this is due to a drift in the condenser 
(either due to staging or source drift). Occasionally, this is due to a misalignment of 
the flight tube (due to mechanical collision with a user). 

Solution 

Switch to the 2X objective and remove each component one by one until the culprit is 
revealed (using the images in chapter 3 as reference). Realign the system according to 
the procedure in chapter 3.  
 
If the condenser was misaligned, try to make adjustments so that the pinhole position 
will remain unchanged (usually, this means adjusting x/y more than tip/tilt). Align the 
condenser and then insert the pinhole. Then, iterate adjusting the condenser and 
removing/inserting the pinhole until the 1st order reflected beam passes through the 
pinhole without tweaking the pinhole position. 
 
If the flight tube was misaligned, remove all components and then adjust the flight 
tube saddles on the detector rail until the beam passes through as in fig. 3-1. Then, 
reinsert all optical components.
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Chapter 12: Additional Information 

12.1 Disposal and decommissioning 

Xradia will assume responsibility for machine disposal and decommissioning. Please 
ship all components back to Xradia for proper disposal. 

12.2 Maintenance 

Please refer to your maintenance contract for the appropriate maintenance schedule. 
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Appendix A: Advanced Alignment Procedures 
 

A.1 Motor Homing 

Due to the dynamic nature of the axis positions, the current positions are not 
automatically stored in permanent memory. As a result, whenever power to the 
motion control hardware is lost, all of the axis positions go with it and must be reset. 
In order to minimize fonusion and ralte past positions to those after a power outage, 
Xradia has implemented a system of homing routines, which align all of the axes to 
hardware reference points with high precision. 
 
When homing is necessary, the user is prompted with a dialog when launching 
TXMController, as pictured below. If this message appears, remove the sample holder 
and click yes to begin execution of the homing routines. 
 

 
Fig. A-1: Automatic prompt if homing is necessary. 

 
If homing cannot be performed immediately, it is also possible to start the sequence 
manually through TXMController. In this case, remove the sample holder as before 
and navigate to Microscope->Home all axes…  
 

 
Fig. A-2: Manual homing. 

 
Once the homing sequence is complete, all axes will be at the positions last marked as 
zero. In any case, system alignment should be checked, as minor corrections are 
typically necessary.  

A.2 Optical axis definition 

The optical axis is defined by the detector rail, which is registered to the optical train 
plate and breadboard. To define the optical axis, use the following procedure: 
 

1. Open the flight tube. then mark the current position of the detector along the 
rail. 
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Fig. A-3: Marking the detector position. 

 
2. Move all components out of the beam path except for the condenser. Make 

sure the condenser is well-aligned. 
3. Move the detector as far downstream (away from the source) as possible and 

take one image. Mark its position on the breadboard. Do not realign the 
condenser, we will just use the projection of the beam stop for measurement. 

4. Move the detector as far upstream (toward the source) as possible and take 
one image. Mark its position on the breadboard. Do not realign the condenser, 
we will just use the projection of the beam stop for measurement. 
 

 
Fig. A-4: Detector moved to downstream (left) and upstream (right) limits. 

 
5. Measure the distance between the detector downstream and upstream 

positions, in mm, and call the distance ∆z. 
6. Use the circle annotation tool on each image to find the center of the beam 

stop (dark circle observed in the center of the condenser image). Take (x1, y1) 
to be the center of the image with the detector downstream and (x2, y2) 
upstream, with the measurements in pixels. Then, define: 
 

∆� � �� � �� 
∆� � �� � �� 

 
7. Calculate the condenser pitch and yaw shift, (∆cP, ∆cY) respectively, via the 

following formulae where b is the binning of the images collected of the 
condenser in the two different detector positions: 
 

∆	
 �
124.1 � 6.5 � ∆� � � 

∆�
 

 

∆	� �
92.3 � 6.5 � ∆� � � 

∆�
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8. Move the condenser pitch by ∆cP and yaw by ∆cY. Use the condenser x and y 
motors to realign the 1st order reflected light to be concentric with the 0th 
order. Move the detector if the condenser goes out of the field of view as a 
result of translation.  

9. Iterate steps 3-8 until the following conditions are satisfied: 
 

6.5 � ∆� � � 

∆�
� 1 

 
6.5 � ∆� � � 

∆�
� 1 

 
10. The optical axis should now be properly defined. 

A.3 Stacked zone plate alignment 

For nanoXCT-100 systems using aligned (“stacked”) zone plates, an additional, 
manual pitch/yaw alignment must be performed to ensure proper operation of the 
lenses. 
 

 
Fig. A-5: Stacked zone plate holders 
installed for HRES (left) and LFOV (right). 

 
The ZP30-320 (used for large field of view) may be aligned without the use of any 
additional lenses, but the ZP35-80 uses the Bertrand lens to image the zone plate in 
order to enable alignment. 
 
The following procedure outlines the necessary steps to align the stacked zone plates 
to the optical axis. 

A.3.1 Large field of view (ZP30-320) 

1. Align the condenser, pinhole, and zone plate as described in section 3.2.2. 
Take one image in the 20X objective with high statistics, then switch back to 
2X. 

2. Take one image with high statistics in the 2X objective (10 seconds at binning 
4 generally works well). 

3. If the zone plates are misaligned, a Moiré fringe pattern will be visible around 
the outside of the condenser ring. Vertical fringes indicate a yaw misalignment 
and horizontal fringes indicate a pitch misalignment. Diagonal fringes indicate 
a combination of pitch and yaw misalignment. 

4. Use an extra-small (0.035”) hex key to make a small adjustment to the 
appropriate set screw. If turning the screw does make a difference, it is 
possible that the set screw is at a travel limit; in that case, use a small 1.5mm 
hex key to adjust the preload screw as appropriate.  

NOTE: It is best to first correct any yaw misalignment and then finish 
with pitch. 
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Fig. A-6: Stacked zone plate holder. 

 
5. Image in continuous mode (e.g., 1 second at binning 4) and use TXMController 

to reposition the zone plate in the center of the condenser ring, as shown in 
section 3.2.2.  

6. Iterate steps 2-5 until the number of fringes diminishes to zero. In the final 
few moves, the fringes will be visible as blockages on the outer edge of the 
condenser ring; small, precise motions with the 0.035” hex key should remove 
these and make the ring uniform. 
 

 
Fig. A-7: Stacked ZP30-320 misaligned in yaw (left) and aligned 
(right), imaged with the 2X objective. 

 
7. Switch back to the 20X objective and take another image with the same 

parameters as in step 1. If the zone plates were misaligned to begin with and 
are now aligned, then mean count rate should increase by approximately a 
factor of 2. 

A.3.2 High resolution (ZP35-80) 

1. Align the condenser, pinhole, and zone plate as described in section 3.2.1. 
Take one image in the 20X objective with high statistics, then switch back to 
2X. 

2. Use the motion controller to move the phase ring X to its negative limit and 
phase ring Z to its positive limit. 

3. Remove the arm that supports the HRES Bertrand lens holder and physically 
shift the Bertrand lens by 20 mm toward the source from its aligned position. 
This generally requires moving the Bertrand lens holder to the very last hole, 
so that it is supported by the rear screw only (the front screw hole hangs over 
the side of the support arm). Then, reinstall the Bertrand lens support arm 
into nanoXCT. 
 

Pitch 
adjustment 
screws 

Yaw 
adjustment 
screws 
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Fig. A-8: HRES Bertrand lens (ZP100-160) physically 
shifted by 20 mm from its designed position. 

 
4. Realign the HRES Bertrand lens (ZP100-160) and center it in the FOV using 

the 2X objective. Switch to the 20X objective and take one image with high 
statistics (e.g., 30 seconds at binning 2).  

5. If a Moiré fringe pattern is visible in the image from the Bertrand lens, then 
the zone plates are misaligned. As in the previous section, vertical fringes 
correspond to yaw misalignment, horizontal to pitch, and diagonal to a 
combination of yaw and pitch. 

6. As in the previous section, adjust the yaw and then pitch using the small hex 
wrenches as appropriate.  

7. Switch back to the 2X objective and translate the zone plate in x and y until 
the illumination is centered inside the condenser ring and around the image 
from the Bertrand lens. Then, switch again to the 20X objective and take one 
image with the same parameters as in step 4.  

8. Iterate steps 5-7 until no fringes are visible.  
 

 
Fig. A-9: Stacked ZP35-80 misaligned in both pitch and yaw 
(left) and aligned (right), imaged with the 20X objective. 

 
9. When the zone plates are finally aligned, move the Bertrand lens by 7 mm to 

remove it from the optical train and take one image with the same parameters 
as in step 1. If the zone plates were misaligned to begin with and are now 
aligned, then the mean count rate should increase by approximately a factor 
of 2. 

10. Shift the Bertrand lens back into its phase ring alignment position by removing 
the support arm from nanoXCT, physically moving the holder back to where it 
started, and then reinstalling the support arm.  
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A.4 Rotation axis alignment 

As part of the setup procedure, particularly for the collection of RSD data, it is 
necessary to align a tungsten STM tip to the physical axis of rotation of the rotation 
stage. This technique is also useful for collection of tomography data when any sample 
is grossly misaligned from the rotation axis (e.g. > 1mm), to minimize the effects of 
stage pitch as the software stage correction translates the sample.  
 
The following procedure outlines the technique for aligning a sample on the flexure-
style holder to the axis of rotation, using a tungsten STM tip mounted in the pin vise 
as the example. The large field of view configuration works best for this technique, but 
the high-resolution configuration is demonstrated here. By the end of this procedure, 
the nanoXCT and pre-alignment microscope (PAM) will be aligned to each other, with 
x=0 and z=0 referring to the axis of rotation. 
 
Hardware rotation axis alignment 

1. Install and focus a test sample. 
Mount a sample in the holder and center it in the field of view. Adjust the 
sample Z position until the image is in sharp focus at θ = 0°. 
 

2. Note the X position of the sample at θ = 0°, 90°, 180°, and 270°. 
Write down the sample X position at θ = 0°. Use the sample theta motor to 
adjust the angle to 90°, 180°, and 270°, noting the X position at each. If the 
sample is far from the rotation axis, it may be helpful to perform a small 
mosaic to ease the process. 
 

 
Fig. A-10: Small mosaic performed to locate sample. 

 
3. Calculate the location of the center of rotation. 

By virtue of this projection-location method, it is possible to calculate the 
displacements necessary along the X and Z axes to bring the sample close to 
the physical axis of rotation. First, use the θ = 0°, θ = 180°, and θ = 270° 
projections to the sample X axis to calculate the position of the center of 
rotation through the following formula: 

2
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where x(0°), x(180°), and x(270°) are the X positions of the sample at θ = 0°, 
θ = 180°, and θ = 270° respectively. 
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4. Calculate the displacement for X and Z. 
Using the value calculated above, the displacements necessary in X and Z may 
be calculated through the following formulae: 

yr

x

crxz

crxx

−°=∆

−°=∆

)90(

)0(  

where x(90°) is the X position of the sample at θ = 0° and x(0°) is defined as 
before. 
 

5. Center the sample on the pre-alignment microscope. 
Remove the sample from nanoXCT and place it into the pre-alignment 
microscope (PAM). Locate the sample first with the 10x objective, and then 
switch to the 50x objective. Use the PAM micrometers to center the sample in 
the crosshairs.  
 

 
Fig. A-11: Tungsten STM tip centered in the 
crosshairs of the PAM. 

 
6. Zero the PAM and physically reposition the sample to the calculated axis of 

rotation. 
With the tip centered in the crosshairs, press the “ZERO/ABS” button on the 
PAM micrometers. Move the micrometers to x=-∆x, z=-∆z, as calculated 
above. Using a small hex wrench, adjust the screws on the sides of the flexure 
base to push the sample back to the crosshairs. It is best to do this without 
switching objectives, if possible. 

  
Fig. A-12: X (left) and Z (right) adjustment of flexure base hardware. 

 
7. Iterate the procedure, if necessary. 

Put the sample back into nanoXCT, and recheck the X positions at the same 
angles as before. Iterate the procedure until all of the positions are within 1-2 
µm of each other. 
 

8. Zero the sample stage motors in TXMController and PAM micrometers.  
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With the sample centered in both nanoXCT and PAM, click the “0” button on 
the sample X, Y, and Z axes in TXMController. Press the “ZERO/ABS” button 
on the PAM micrometers as before. Both instruments are now aligned to each 
other as well as the axis of rotation of the sample stage. 
 

  
a) Click the “0” button on each axis to 

zero the software. 
b) Press the “ZERO/ABS” button to zero the 

micrometer. 
Fig. A-13: Zeroing NCT (a) and PAM (b). 

A.5 RSD calibration 

In order to overcome systematic wobble of the rotation stage, TXMController version 
5+ has an integrated correction routine to shift the sample in the x-direction during 
tomography, thus aligning the sample to a virtual rotation axis. This is called “rotation 
stage deviation” (RSD) correction, and involves the software reading shift values from 
a text file that resides in the path of the program. 
 
The following procedure outlines the steps necessary to generate the text file and 
describes the process of enabling the correction routine.   
 

A.5.1 Generating the RSD file 

1. Follow the procedure to align a sample (e.g., tungsten STM tip) to the rotation 
axis using the hardware method. Iterate the procedure until variations 
between 0, 90, 180, and 270 degree sample theta positions are within 2 µm of 
each other. 

2. Collect three tomographic data sets using the following parameters: 
Start angle:  - 180 deg 
End angle:  +180 deg 
Step:   1 deg 

3. Align the first data set using TXMController’s alignment feature. After clicking 
the “align” button, navigate to C:\Program Files\Xradia Inc\Micro-XCT, and 
locate the file called XYShifts.txt. Copy this file to a new location and rename it 
to rsd1.txt. 

4. Repeat step 3 for the second and third data sets, calling them rsd2.txt and 
rsd3.txt respectively. 

5. Import the XShifts list from each rsdX.txt file into your favorite data analysis 
program (e.g., Igor, MATLAB, Microsoft Excel, etc.), and create a new data set 
consisting of the mean values of each line. 

6. Multiply each mean value by the pixel size, in microns, of the collected data 
sets. 

7. Export this new data set, which should have 361 lines, to a text file, and call it 
RotationStageDeviation.txt. Open the file in a text editor and insert one line at 
the top exactly as below: 
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//////Rotation Stage Deviation -- DO NOT DELETE THIS LINE/////// 
8. Navigate back to C:\Program Files\Xradia Inc\Micro-XCT\, and open the 

directory called StageCorrection. If this directory does not exist, then create it. 
9. With TXMController closed, copy the RotationStageDeviation.txt file into 

C:\Program Files\Xradia Inc\Micro-XCT\StageCorrection. 
 

A.5.2 Enabling RSD correction 

1. Open TXMController. 
2. Navigate to Microscope->Configure System.  
3. At the top of the system configure window, select the check box next to “Apply 

stage correction.” Stage correction values in this window may both be set to 
zero. 

4. Click OK in the system configure window. RSD is now enabled.  

A.5.2 Example RotationStageDeviation.txt file 
//////Rotation Stage Deviation -- DO NOT DELETE THIS LINE/////// 

-0.516 

-0.43 

-0.774 

-1.204 

-1.892 

-1.29 

-1.892 

-1.978 

-1.548 

-1.032 

-2.322 

… etc … 

A.6 CCD rotation correction 

Whenever a new CCD camera is installed, its rotation relative to the axes of the other 
staging must be adjusted to within Xradia’s specification of 1 mrad. In this section, a 
procedure for checking and correcting the CCD rotation is outlined. 
 

1. Locate an appropriate sample for the correction procedure. The preferred 
sample is a test pattern mounted on a thin rod, but a test pattern mounted in 
a standard sample holder, when used with extreme caution when rotating at 
high angles where collision with the pinholes is possible, can work as well.  

 

 
Fig. A-14: Star pattern mounted on a 
thin rod, thus allowing full 180°°°° rotation. 

 
2. Using the PAM, align the test pattern to the rotation axis as best as possible. 
3. Insert the pattern into NCT and take a single image for reference. 



 

4. In one corner of the test pattern, there is a 30 x 30 
located ~ 45 µm in x and y from the center. Locate this region using binning 
no greater than 2. 

 

Fig. A-
pattern measures roughly 100 

the Au dot pattern is pictured in the upper left corner.

 
5. Take one single, low

image to take will encompass as many of the dots as possible in both 
directions, but retain the outer edge of the test pattern in the FOV (see figure 
below). 

6. Rotate sample theta to 180
single image with the same acq

CAUTION:

remove the sample holder completely from the stage before rotating 
and immediately after image collection (the system will automatically 
return to 0

 

Fig. A-16: NCT image of the Au dot array at 0

In this example, the circled dots are used for measurement.

 
7. Use the circle annotation tool to draw a 

both images and separated by a reasonably large distance along the diagonal. 
Measure the distance between the centers of the dots and use the following 
formula to calculate the current CCD rotation.

Au dot 
pattern 

Recommended 
HRES FOV 

(x2, y2) 

(x1, y1) 
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In one corner of the test pattern, there is a 30 x 30 µm array of Au dots 
m in x and y from the center. Locate this region using binning 

no greater than 2.  

 
-15: CAD model of the “star” test pattern. The 

pattern measures roughly 100 µµµµm from edge to edge, and 

the Au dot pattern is pictured in the upper left corner. 

Take one single, low-binning exposure (e.g. 300sec at binning 1). The best 
to take will encompass as many of the dots as possible in both 

directions, but retain the outer edge of the test pattern in the FOV (see figure 

Rotate sample theta to 180° and locate the same region as before. Take a 
single image with the same acquisition parameters as before.  

CAUTION: If the standard sample holder is used, make sure to 
remove the sample holder completely from the stage before rotating 
and immediately after image collection (the system will automatically 
return to 0° after collecting a single image). 

 
: NCT image of the Au dot array at 0°°°° (left) and 180°°°° 

In this example, the circled dots are used for measurement. 

Use the circle annotation tool to draw a circle around a pair of dots visible in 
both images and separated by a reasonably large distance along the diagonal. 
Measure the distance between the centers of the dots and use the following 
formula to calculate the current CCD rotation. 

m array of Au dots 
m in x and y from the center. Locate this region using binning 

: CAD model of the “star” test pattern. The 
m from edge to edge, and 

binning exposure (e.g. 300sec at binning 1). The best 
to take will encompass as many of the dots as possible in both 

directions, but retain the outer edge of the test pattern in the FOV (see figure 

and locate the same region as before. Take a 

If the standard sample holder is used, make sure to 
remove the sample holder completely from the stage before rotating 
and immediately after image collection (the system will automatically 

 
(right). 

circle around a pair of dots visible in 
both images and separated by a reasonably large distance along the diagonal. 
Measure the distance between the centers of the dots and use the following 

(x1
’, y1’) 

(x2
’, y2’) 



 

 

CCD rotation off

8. If the CCD rotation offset value is more than 0.001 rad, then it needs to be 
corrected. Assuming that TXMConfigure has the main camera orientation set 
correctly:  

(y2
’ – y

(y2
’ – y

Rotate the CCD is the appropriate direction by loosening the four screws 
around the base of the CCD, adjusting the manual micrometers with a hex 
key, and then retightening the four screws. 
corresponds to approximately 0.005 rad.

 

Fig. A-17: The four screws (left) around the base of the CCD must be 
loosened before rotation adjustment and then retightened after. The 
manual micrometers (right) work in a push
CCD and are adjusted by using a small hex wrench.

 
9. Iterate steps 5
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CCD rotation offset = 
( ) ( )

''

''

2121

2121

xxxx

yyyy

−+−

−−−
 [radians] 

If the CCD rotation offset value is more than 0.001 rad, then it needs to be 
corrected. Assuming that TXMConfigure has the main camera orientation set 

y1’) < (y2 – y1) ⇒ rotate CCD counterclockwise 
y1’) > (y2 – y1) ⇒ rotate CCD clockwise 

Rotate the CCD is the appropriate direction by loosening the four screws 
around the base of the CCD, adjusting the manual micrometers with a hex 
key, and then retightening the four screws. 1 rotation of the mi

corresponds to approximately 0.005 rad. 

 
: The four screws (left) around the base of the CCD must be 

loosened before rotation adjustment and then retightened after. The 
manual micrometers (right) work in a push-pull manner to rotate 
CCD and are adjusted by using a small hex wrench. 

Iterate steps 5-8 until the measured CCD rotation offset is less than 0.001 rad.
 

If the CCD rotation offset value is more than 0.001 rad, then it needs to be 
corrected. Assuming that TXMConfigure has the main camera orientation set 

Rotate the CCD is the appropriate direction by loosening the four screws 
around the base of the CCD, adjusting the manual micrometers with a hex 

1 rotation of the micrometers 

 
: The four screws (left) around the base of the CCD must be 

loosened before rotation adjustment and then retightened after. The 
pull manner to rotate the 

8 until the measured CCD rotation offset is less than 0.001 rad. 
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Appendix B: X-ray Generator Procedures 
 

B.1 Powering down the x-ray generator 

To bring the x-ray generator from a full operating state to a powered-off state, 
following the procedure outlined in this section. Please note that this procedure takes 
approximately 2 hours to fully complete. 

1. Use the automated aging routine under the software source control advanced 
options  to slowly age the source down to 20 kV x 10 mA.  

NOTE: If software source control is not available or not functioning 
properly, then use the buttons on the front of the x-ray generator panel. 
First, decrease the current to 10 mA in 5 mA increments, pausing for 1 
minute between each step. Next, decrease the voltage to 20 kV in 5 kV 
increments also pausing for 1 minute between each step. 
 

 
Fig. B-1: Relevant generator controls. 

 
2. Allow the system to stabilize for 5 minutes at low power (20 kV x 10 mA). 
3. Use the x-ray OFF button under the software source control advanced options 

to turn off x-rays. The red light on top of the enclosure should turn off along 
with the x-rays. 

NOTE: If software source control is not available, not functioning properly, 
or if the red light on top of the generator does not turn off, then use the 
button on the front of the x-ray generator panel. Locate the button labeled 
OFF under the “X-ray” strip and press it. Verify that the red light turns off 
as well. 

4. Allow the system to sit in this state for 1 hour. While x-rays are not being 
produced, cooling water is still flowing to the anode allowing it to cool 
properly. 

CAUTION: Failure to follow this step may result in damage to the anode. 
5. Use the vacuum stop button under the software source control advanced 

options to stop the vacuum pumps.  
NOTE: If software source control is not available or not functioning 
properly, then use the button on the front of the x-ray generator panel. 
Locate the button labeled STOP under the “vacuum” strip and press it. 
Verify that the roughing pump stops running. 
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Fig. B-2: Vacuum stop and power-off buttons. 

 
6. Use the power OFF button under the software source control advanced options 

to turn off power to the x-ray generator control systems. 
7. Allow the system to sit in this state for a minimum of 30 minutes.  

CAUTION: Failure to follow this step may result in damage to the turbo 
molecular pump (TMP). 

8. Open the bottom access panel and located the “Main Power” strip. Press the 
button labeled OFF. 

 
Fig. B-3: Main power off. 

9. Open the rear access door and locate the circuit breaker. Rotate this to the 
OFF position and use a standard safety lock to secure it in place. 

 

 
Fig. B-4: Circuit breaker 

B.2 Powering up the x-ray generator 

Taking the x-ray generator from its completely powered down state to its operating 
conditions is roughly the reverse of the previous procedure: 

1. Rotate the circuit breaker on the rear of the generator to the ON position. 
2. Press the main power ON button on the front of the generator and wait for 30 

seconds.  
3. Press the START button under the vacuum strip.  
4. When the number on the STATE screen has decreased below 180 mV, press 

the power ON button in the software source control advanced options (or press 
the physical ON button under the “power” strip on the generator). Wait 30 
seconds for the control system to stabilize. 
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5. Press the x-ray ON button in the software source control advanced options (or 
press the physical ON button under the x-ray strip on the generator). 

6. Allow the system to settle until the value under the STATE screen has 
decreased back to below 180 mV. Depending on how long the system has 
been off, this may take anywhere from 10 minutes to 24 hours. If the value 
does not decrease below 180 mV in this time frame, please contact Xradia for 
support. 

7. Use the automated aging up routine in the software source control advanced 
options  to bring the source back up to full power. Alternatively, increase the 
voltage to 40 kV using the buttons on the front of the x-ray generator control 
panel in 5 kV steps pausing 5 minutes in between each step (or longer if the 
STATE does not drop below 180 mV in this time period), and then increase the 
current to 30 mA in 5 mA increments pausing 5 minutes in between each step 
(same condition as previous applies). If the system has been off for more than 
a couple of weeks or exposed to air for longer than a few hours, follow the 
procedure for “SHORT_TIME aging” in the Rigaku manual. 

8. If the generator has been off for more than a few minutes, allow the source to 
settle for a minimum of 3 hours before beginning system alignment. 

B.3 Filament service 

Approximately every 3 months or 3000 x-ray hours, the x-ray source will require a 
minor anode/cathode service (filament change). This is usually indicated by x-rays 
turning on briefly and then abruptly turning off with an alarm on the x-ray generator. 
 
Filaments are user-serviceable parts by following the procedure outlined in this 
section. If there are any questions that arise before, during, or after the service, 
please contact Xradia for support.  
 
There are two components to the filament service procedure. The first involves 
changing the filament itself, and the second polishing the anode. Servicing the anode 
is not strictly necessary in order to bring the machine back to operation, however it is 
recommended in order to maintain maximum x-ray flux from the source. 
 

CAUTION: Laboratory gloves must be worn while performing this procedure and 
changed as soon as they become significantly unclean. Any skin oils, if deposited 
inside the rotating head or on one of the sensitive components, could seriously 
damage the system leading to costly vacuum repairs. Nitrile is the preferred 
material, but latex or vinyl will work as well. One pair of gloves is provided in the 
Rigaku toolbox.  

 
B.3.1: Changing the filament 

1. Power down the x-ray generator by following the procedure in section B-1.  
2. Loosen the vacuum bleed valve on the far side of the generator and allow the 

head assembly to vent for a few minutes. 
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Fig. B-5: Vent the vacuum chamber with the 
screw on the far side of the head assembly. 

 
3. Remove the six screws around the outside of the side filament access panel on 

the anode. Make sure to support the panel while removing the final two 
screws. 

 

 
Fig. B-6: Gain access to the filament by removing the side panel. 

 
4. Remove the panel and set it and the o-ring aside on a clean surface (clean 

room wipes work well for this purpose). 
 

  
Fig. B-7: Remove the panel and set it aside. 

 
5. Using a hex wrench cleaned with methanol, carefully unscrew the cover to the 

filament housing while supporting it with another hand, and set it aside on 
another clean surface. Note that the retaining screw will not come out of the 
housing cover. 
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Fig. B-8: Remove the filament housing cover. 

 
6. Using another hex wrench cleaned with methanol, carefully unscrew the two 

wire leads connecting the power supply to the filament. Allow them to dangle. 
Note that these screws also will not come out of the wire leads. 

 

   
Fig. B-9: Disconnect the wire leads from the filament. 

 
7. While supporting the filament housing with one hand, slowly begin to loosen 

the two screws at the bottom of the filament housing. The housing has slots at 
the bottom, so the screws need not be completely removed. Once it is free, 
slide it up and out of the housing, and place it on a clean surface. 
 

    
Fig. B-10: Remove the filament housing. 

 
8. Remove the center screw on the filament and remove the filament from the 

housing. Set the filament aside. Be sure to save the screw because it will be 
necessary for installation of the new filament. 
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Fig. B-11: Remove the old filament. 

 
9. Remove the three screws around the window of the housing and separate the 

components of the housing on the clean room wipe. 
 

 
Fig. B-12: Disassemble the housing in 
preparation for cleaning. 

 
10. Using fine-grade abrasive scrubbers (provided with the system in the Rigaku 

toolbox, e.g. fine grade Scotch-Brite pads) and methanol, clean the housing, 
window, and housing cover, paying close attention to the slot in the window. 
Alternate between moistening the part with methanol, scrubbing with the 
abrasive pad, and repeating. When the gloves become dirty, change them. 
Ocassionally, wipe the item with a lint-free delicate wipe (e.g., clean room 
wipe) and observe what comes off. When the parts wipe clean, stop scrubbing 
and put the window back on the housing – the parts are ready for 
reinstallation.  

 

  
Fig. B-13: Clean the window as well as the rest of the housing. 
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11. Locate the new filament. Carefully remove it from the packaging and set the 
screw aside. Without touching the filament, place it in the appropriate groove 
of the housing so that it is well-centered in the window. Then, secure it in 
place using the original screw (removed with the old filament). 

CAUTION:  
1) Failure to properly center the device will result in both reduced x-

ray flux and a reduced lifespan for the filament. Placing the 
window against a white background often helps to ensure 
adequate centering. 

2) Always use the old screw (slightly green in color) to secure the 
filament in place. The stainless steel screws that come with the 
new filaments are only to hold them in place during shipping and 
are not able to handle the high temperatures present inside the 
anode. Using the wrong screw may result in serious damage to the 
unit. 

 

 
 

 
Fig. B-14: Install the new filament. 

 
12. With clean gloves, carefully place the housing assembly back inside the head 

unit and secure it with the same two screws from which it was originally 
removed.  
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Fig. B-15: Reinstall the housing 
into the head assembly. 

 
13. Connect the two wire leads to the new filament.  

 

 
 

14. Reinstall the housing cover, putting just enough torque on the screw to hold it 
in place. This screw is easy to break, so do not over tighten. If any resistance 
is felt while installing it, stop, back the screw out, and run a standard M3 tap 
through the hole before trying again. 
 

 
 

15. Reinstall the cathode chamber cover, again using just enough torque to keep it 
in place (the vacuum will do the rest of the work). 
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B.3.2: Polishing the anode 

1. With the source and vacuum still off, remove the acorn nuts around the anode 
access panel. Before removing the final nuts, make sure to support the panel 
in case it should fall. When all nuts have been removed, hold the panel by its 
two handles and slowly pull it away from the enclosure. It is quite heavy, so 
be prepared to support about 10 kg of weight.  
 

 
 

2. Take note of the position of all hoses going into the anode and then disconnect 
them. Have a small cup and towels nearby to catch any water that may leak 
out. Water hoses may be removed by pushing in on the outer collar of the 
connector and then pulling out the hose. 
 

 
 

3. Using a Phillips-head screwdriver, remove the four screws around the edge of 
the anode while supporting it with a spare hand (or the help of a colleague).  
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4. Pull the anode out until it stops. Then, slide it approximately 2 cm to the left 
and very gently pull it out of the assembly. The size of the anode is a very 
tight fit with respect to the generator but contact with the walls should be 
avoided. 
 

   

  
 

5.  Place the anode on a clean, lint-free surface (e.g. clean room wipe).  
 

 
 

6. Using methanol and abrasive pads, scrub the surface of the target until a clean 
copper surface has been revealed. Then, wipe it with the clean, lint-free wipes 
until they wipes come away with no discoloration or debris. 
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7. Carefully insert the polished target back into the head assembly with the flat 
portion facing to the left, avoiding any contact with the walls. Slide it in until it 
stops, then slide it over to the right until the outer mount is flush with the 
surface of the head assembly. 
 

  
 

8. Secure the anode by reinstalling the four Phillips-head screws around its 
perimeter. 
 

 
 

9. Reinsert the water hoses into their proper connectors. 
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10. Close the vacuum bleed valve. 
 

 
 

11. Follow the procedure in the previous section for powering up the x-ray 
generator to bring the system back into its operational state. Allow at least 3 
hours for the x-ray beam to stabilize on the fresh target surface, but be aware 
that the beam may continue to drift over the next few days (so frequent 
alignment checks will be necessary).



 79 

Appendix C: Technical Specifications 

C.1 Facility requirements 

1. Room size 
The room must be ~ 4 m x 5 m to house the nanoXCT, water chiller, computer 
workstation, pre-alignment microscope, and other items. 
 

 
Fig. C-1: Minimum floor plan for NCT system. 

 
2. Door entrance width and height 

The entrance width must be 1.6 m wide x 2.5 m high to allow passage of the nanoXCT 
unit. 

3. Floor load capacity & vibration spectrum 
The floor must have a load capacity of at least 500 kg/m2 and be free of sensible 
vibration. The figure below shows a typical floor vibration spectrum with < 100 nm 
integrated peak-to-peak amplitude. 
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Fig. C-2: Floor spectrum as measured at Xradia laboratory. 

 
4. Footprint of nanoXCT 

2.0 m length 
1.3 m depth 
2.0 m height 

5. Water chiller 
A closed-loop water chiller is supplied by Xradia. The footprint is 0.5 x 0.9 x 1 m, and 
placement must be within 4 m from the generator. It is recommended to place the 
chiller in a separate room to reduce noise. 
The chiller requires 5 gallons of distilled water, which is kept in closed-loop circulation 
at ~ 1.1 gpm. 
The customer is expected to supply house water with 25-35 PSI pressure differential 
for heat rejection. Tap water may be used for this purpose with drainage to a sink. 

6. Electricity 
a. nanoXCT unit 

200 VAC ±10% 
60 Hz 
20 A 
3 Φ 

b. Water chiller 
208/230 V 
60 Hz 
15 A 
1 Φ 

7. Room temperature 
The room temperature should be kept between 65 to 75 °F (±1 °F) with humidity < 
70%.  

8. Other 
a. Electromagnetic compatibility 

There are no special requirements for electromagnetic compatibility. 
b. Helium gas 

An industrial-purity helium supply (bottle or central) is expected with a 
regulator set to <100 PSI. 

c. Desk space 
i. A computer desk of at least 30” width, 24” depth is expected for the 

computer workstation. Risers for the computer tower are strongly 
recommended. 

ii. A sturdy desk or laboratory bench with 1 x 1 m surface is expected, 
capable of supporting 200 lbs. 
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C.2 X-ray nano-tomography system 

 

X-ray Energy [keV] 8.04 (Cu anode) 
X-ray Source Microfocus rotating anode 
X-ray Condenser System Reflective ellipsoidal mirror 
High Resolution X-ray Objective Lens Diffractive 

Fresnel zone plate 
X-ray Detector Type CCD sensor optically coupled to scintillating 

screen – 16 bit 

Detector pixels 1024 x 1024 
Large Field of View Optics (Standard) 150 nm spatial resolution (Rayleigh) 

60 µm field of view 
65 nm pixel size 
Absorption contrast 
Zernike phase contrast 
(60 µm)3 CT reconstruction volume 
60 µm depth of focus 
4 hr CT acquisition time for 5% contrast 

High Resolution Optics (Optional) 50 nm spatial resolution (Rayleigh) 
15 µm field of view 
16 nm pixel size 
Absorption contrast 
Zernike phase contrast 
(10 µm)3 CT reconstruction volume 
20 µm depth of focus 
12 hr CT acquisition time for 5% contrast 

Computed Tomography Hardware accelerated parallel beam 
1k x 1k x 1k reconstruction in 15 min 

Working Distance [mm] 
(Distance Sample to Optics) 

>10mm 

Sample stage load capacity [kg] 
(Sample holder + sample) 

2 

Sample pre-alignment station Optical microscope with 10x and 50x optical 
magnification, CCD camera, monitor 

Computer Two dual core Intel Xeon 2.66GHz processors 
4GB Ram 
RAID5 HD array 146GB 
Microsoft Windows XP 
30” flat panel display 

Software Xradia microscope control software 
Xradia hardware accelerated CT 
reconstruction software 
Xradia 3-D viewer and analysis software 
Microsoft Office Professional 

Enclosure Radiation safe 4-door enclosure with safety 
interlock and x-ray on indicator light 

Weight 2600 kg 
Warranty 12 months for full parts and labor, against 

manufacturing defects 

 

C.3 Application-relevant specifications 

 
X-ray Attenuation Length @ 8keV [µm] 
(Recommended max. sample thickness for 
solid sample with material indicated) 

Carbon (C): 1000 
H2O: 1000 
Silicon (Si): 70 
Aluminum (Al): 80 
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Iron (Fe): 5 
Maximum recommended sample size [mm] 1 x 5 x 10 

Space available for custom sample 
environment 

The standard Xradia sample holder can be 
modified by the customer for additional 
sample manipulation (environment, 
stress/strain, temperature, etc.) 
Drawings are available upon request 

 

C.4 X-ray source specifications 

The Xradia nanoXCT x-ray microscope incorporates a proven, state-of-the-art, high-
flux x-ray generator manufactured by Rigaku Corporation.  
 

Manufacturer: Rigaku 
Type: MicroMaxTM-007 HF 

Microfocus Rotating Anode 

Focal Spot Size [µm] 70 
Target Power [kW] 1.2 (Cu anode) 
Tube Voltage [kV] 40 (Cu anode) 

Anode Material Cu 
Characteristic X-ray Energy [keV] 8.04 (Cu anode) 
Maintenance Intervals [months]1 • Approx. every 3 months:  

Filament replacement 
• Approx. every 6 months: 

Anode inspection / polishing 
• Every 12 months:  

Refurbishment of Target anode 
Extended Maintenance Options  
(after expiration of 1 year warranty) 

• Included with Xradia extended 
maintenance package (recommended) 

• Directly from Rigaku USA 
Consumables X-ray source filament (2500 hrs life) 

Available directly from Rigaku USA (Part 
Number RAG-4894A111 for package of three) 
or from Xradia factory 

1based on continuous usage of source 

C. 5 Spare parts 

Part No. Description 

9000050 Graphics card 

9000079 Actuator 

9000093 Copper anode, MicroMax-007HFM 

9000131 Perc 5/E SAS RAID adapter battery 

9000593 Gold powder spherical, APS 0.8-1.5 um 1g size 

9000594 Gold powder spherical, APS 1.5-3.0 um 1g size 

9000602 4 channel servo card, UMAC 

9000603 Interpolation 1000, output frequency 1.8 MHz 

9000680 Filament ST/3, AP5S point focus 

9000685 De-I filter cartridge, NGDI-10 

9000686 Nylon suction strainer 

9000687 30- micron filter 

9000869 Lamp, Eke, 150W, 21 V, halogen bulb 

9000870 Battery, SR-44, silver oxide, 1.55V 
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1005-064 Detector mirror mount 

1005-310 Sample holder, notched, assy 

1007-172 2X Nikon sleeve 

1018-065 Zone plate holder 

1018-080 Flexure hinge 

1018-205 Scintillator + mirror ass. 

4000-0052 Power supply for Pixis 1024B 

9000-293 Vacuum pump, turbomolecular, 500 lps 

9100-074 Adjustment screw 

9100-137 Port window 2" dia 

9100-138 Port o-ring 

9100-146 Welded bellows 

9100-294 20X objective, Nikon 

9100-540 LIA encoder, 1m cable 

9100-615 Mounting scale with adhesive 

9100-722 .250 dia Be window buff both side's 

9200-007 Rotation stage 

9200-008 Micrometer not encoded 

9200-156 Micrometer 

9200-165 4 channel stepper encoder 

9200-184 Digital CCD Pixis camera 

9200-187 Turbo UMAC CPU board 

9200-399 DC motor closed loop 

9200-402 DC motor closed loop 12.5mm travel 

9200-443 Dell, secondary workstation 

9200-449 Stepper drive, 0-2A, 256 microstepping 

9900-022 18-8 SS sealing pan head phil machine screw 6-32 

9900-105 1/8 tube 1/8 NPT SS fitting 

9900-113 Tungsten tip probe (box of 25) 

A000067 Be window and flange assy 

A000140 Pinhole assembly, 60 um 

A000339 ZP2 + holder assembly labtool 

A000341 ZP4 + holder assembly labtool 

A000345 PR 1 assembly with holder 

A000346 PR 2 assembly with holder 

A000349 Bertrand lens 1 assem. Holder labtool 

A000351 Bert. Lens assem. 2 holder labtool 

A000370 ZP 1 assembly with tip tilt 

A000371 ZP 3 LFOV with tip tilt 

M000198 Condenser extension 
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Appendix D: Electrical Documentation 

D. 1 Interconnect Diagram 
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D. 2 Motion Control Rack 
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D. 3 Motion Control Interconnect 
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D. 4 Power Distribution Unit 
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Appendix E: Contact Xradia, Inc. 
 
If assistance is needed on the nanoXCT instrument, please contact the Xradia support team 
using one of the following methods: 
 
Internet 

support@xradia.com 
 
Telephone 

+1 (925) 288-1228 
 
Mail 

Xradia, Inc. 
5052 Commercial Cir. 
Concord, CA 94520 
USA 


